The Scoring and Analysis Guide for Assessing Human Well-Being is designed to supplement The BAG and The Grab Bag. It provides a scoring method that can be used with the two manuals, to come to a decision about particular criteria and indicators in particular forest and human settings. Following the section on scoring is a section on analysis. It begins very simply, leading the user through the steps of making a spreadsheet, and concluding with more complex statistical analyses that may be desirable in some circumstances. Different teams have different requirements for quantitative and statistical sophistication in their analyses. This manual responds to these differing needs.
Scoring and Analysis Guide for Assessing Human Well-Being

Agus Salim and Carol J. Pierce Colfer
with Cynthia McDougall

7

The Criteria & Indicators Toolbox Series
Table of Contents

Introduction ........................................................................................................... 1

I – The Scoring Guide .......................................................................................... 11

II – Master C&I Spreadsheet ............................................................................... 31

III – Quantitative Analysis Guidelines ................................................................ 49

A – Analysis of results from a stakeholder identification method (CatPac) ........... 51
B – Analysis of methods on security of intergenerational access to resources ....... 58
C – Analysis of methods for rights and means to manage ................................... 109
D – Conclusions .................................................................................................... 134
E – Bibliography .................................................................................................. 136

Appendix A: Checking regression analysis assumptions ....................................... 137

List of Figures

Figure 1. Computer screen showing part of a master C&I spreadsheet ................. x

CatPac

Figure 2. Cognitive map for baka females (Dja Reserve, Cameroon) .................. 57

Histo-ecological matrix

Figure 3. Spreadsheet format for histo-ecological data ...................................... 58
Figure 4. Choosing add-ins submenu (histo-ecological data) ............................. 59
Figure 5. Choosing specified add-ins module (histo-ecological data) ................. 60
Figure 6. Starting regression analysis for histo-ecological data ......................... 61
Figure 7. Defining variable’s cell range (histo-ecological data) ....................... 62
Figure 8. Output of regression analysis for histo-ecological data ...................... 63

Access to resources by generation

Figure 9. Spreadsheet format for inter-generation data .................................... 65
Figure 10. Label button (inter-generation data) ................................................... 66
Figure 11. Defining labels for gender on inter-generation data ......................... 67
Figure 12. Choosing type of boxplot for inter-generation data ......................... 69
Figure 13. Choosing variables of inter-generation data need to be checked ......... 69
Figure 14. Boxplot for inter-generation data ...................................................... 70
TABLE OF CONTENTS

Figure 15. Selecting inter-generation variables ................................................. 71
Figure 16. SPSS table describing distribution of access to resources across generation, according to all respondents ................................................................. 72
Figure 17. Pivot table wizard (inter-generation data) ........................................... 73
Figure 18. Constructing pivot table for simple analysis on inter-generation data (step 1) 73
Figure 19. Constructing pivot table for simple analysis on inter-generation data (step 2) 74
Figure 20. Changing default statistic on inter-generation data .............................. 75
Figure 21. MS Excel table describing distribution of access to resources across generation, according to all respondents ................................................................. 76
Figure 22. Selecting inter-generation variables to be summarised ......................... 77
Figure 23. Selecting demographics variable on inter-generation data ..................... 78
Figure 24. SPSS table describing comparison of distribution of access to resources across generation based on ethnicity ................................................................. 79
Figure 25. Selecting statistical test for testing agreement on inter-generation data ........ 80
Figure 26. Selecting test variables and grouping variable (inter-generation data) ...... 81
Figure 27. Defining range for grouping (demographics) variable (inter-generation data) 81
Figure 28. Output of statistical test for each generation (inter-generation data) ......... 82
Figure 29. Constructing pivot table for advanced analyses on inter-generation data .... 83
Figure 30. MS Excel table describing comparison of distribution of access to resources across generation based on ethnicity ................................................................. 84

Benefit sharing among stakeholders
Figure 31. Spreadsheet format for forest benefits data ....................................... 85
Figure 32. Label button (forest benefits data) ..................................................... 87
Figure 33. Defining labels for educational level on forest benefits data .................. 88
Figure 34. Choosing type of boxplot for forest benefits data .............................. 90
Figure 35. Choosing variables of forest benefits data need to be checked .............. 90
Figure 36. Boxplot for forest benefits data ......................................................... 91
Figure 37. Step 1 of selecting variables to be summarised (forest benefits data) ....... 92
Figure 38. Step 2 of selecting variables to be summarised (forest benefits data) ....... 92
Figure 39. SPSS table describing forest benefits distribution according to all respondents 93
Figure 40. Pivot table wizard (forest benefits data) ............................................. 94
Figure 41. Constructing pivot table for simple analysis on forest benefits data (step 1) 94
Figure 42. Constructing pivot table for simple analysis on forest benefits data (step 2) 95
Figure 43. Changing the default statistic on forest benefits data ........................... 96
Figure 44. MS Excel table describing forest benefits distribution according to all respondents ................................................................. 97
Figure 45. Selecting cases for specified subgroup (forest benefits data) ....................... 98
Figure 46. Filtering lower education level respondents on forest benefits data .............. 99
Figure 47. Cases selection result (forest benefits data) ............................................. 100
Figure 48. Forest benefits distribution among stakeholders according to respondents
   with lower educational level ................................................................. 101
Figure 49. Comparison of forest benefits distribution among stakeholders to
   respondents with lower educational level .............................................. 101
Figure 50. Filtering data for kenyah and selecting statistical test (forest benefits data) .... 103
Figure 51. Selecting test variables and grouping variable (forest benefits data) ............ 104
Figure 52. Defining range for grouping variable (forest benefits data) ....................... 104
Figure 53. Output of statistical test for kenyah based on educational level
   (forest benefits data) ............................................................................. 106
Figure 54. Constructing pivot table for advanced analysis on forest benefits data .......... 107
Figure 55. MS Excel table describing comparison of forest benefits distribution
   based on educational level ..................................................................... 108

Right to manage among stakeholders
Figure 56. Spreadsheet format for right to manage data ............................................. 110
Figure 57. Label button (right to manage data) ....................................................... 112
Figure 58. Defining labels for educational level (right to manage data) ..................... 112
Figure 59. Choosing type of boxplot for right to manage data ................................. 114
Figure 60. Choosing variables of right to manage data need to be checked ............... 114
Figure 61. Boxplot for right to manage data ......................................................... 115
Figure 62. Step 1 of selecting variables of right to manage data to be summarised ....... 116
Figure 63. Step 2 of selecting variables of right to manage data to be summarised ....... 116
Figure 64. SPSS table describing distribution of right to manage among stakeholders,
   according to all respondents .................................................................. 117
Figure 65. Pivot table wizard (right to manage data) ................................................. 118
Figure 66. Constructing pivot table for simple analysis on right to manage data (step 1) .. 119
Figure 67. Constructing pivot table for simple analysis on right to manage data (step 2) .. 119
Figure 68. Changing the default statistics on right to manage data ............................ 120
Figure 69. MS Excel table describing distribution of right to manage among
   stakeholders, according to all respondents ............................................... 121
Figure 70. Selecting cases for specified subgroup (right to manage data) .................... 122
Figure 71. Filtering lower education respondents on right to manage data .................. 123
Figure 72. Cases selection result (right to manage data) ........................................... 124
Figure 73. Distribution of right to manage data among stakeholders, according to respondents with lower educational level .................................................. 125
Figure 74. Comparison of right to manage distribution based on educational level .................................................. 126
Figure 75. Filtering data for punan (right to manage data) .................................................. 127
Figure 76. Selecting statistical test for testing agreement on right to manage data .................................................. 128
Figure 77. Selecting test variables and grouping variables (right to manage data) .................................................. 129
Figure 78. Defining range for grouping variable (right to manage data) .................................................. 129
Figure 79. Output of statistical test for punan based on educational level (right to manage data) .................................................. 131
Figure 80. Constructing pivot table for advanced analysis on right to manage data .................................................. 132
Figure 81. MS Excel table describing comparison of right to manage distribution based on educational level .................................................. 133
Checking regression analysis assumptions
Figure 82. Some pattern of residual variances .................................................. 137
Figure 83. Normal probability plot of residual .................................................. 138
Figure 84. Plots show autocorrelated residual .................................................. 140

List of Tables
Table 1. Sample listing of cases with associated scoring, from Danau Sentarum Wildlife Reserve, 1996 .................................................. x
Table 2. Sample table, showing scores by three assessors for a sub-set of C&I (on forest management maintains or enhances fair inter-generational access to resources and economic benefits) .................................................. 47
Introduction
The ability to assess human well-being has been increasingly recognised as an important element in assessing sustainable forest management around the world in recent years. The ten tools in CIFOR’s C&I Toolbox include a generic set of principles, criteria and indicators, and related methods. These are designed to help people make assessments of management in particular production forests where people live and work in and around the forest. The assessments include aspects relating to management, the environment and human well-being. Potential assessors might be project managers, certifiers, donors, government agencies, researchers, NGOs, and communities.

This tool, The Scoring and Analysis Guide, provides the user of the C&I Generic Template and the methods proposed in The BAG and The Grab Bag with help in scoring of human well-being, for the people in a particular forest. Criteria and indicators for human well-being are classified under three principles, with the following weightings:

Human well-being = \[P1(\text{score}) \times W1\] + \[P2(\text{score}) \times W2\] + \[P3(\text{score}) \times W3\].

<table>
<thead>
<tr>
<th>P1</th>
<th>Forest management maintains or enhances fair intergenerational access to resources and economic benefits. W1 = 40%</th>
</tr>
</thead>
<tbody>
<tr>
<td>P2</td>
<td>Concerned stakeholders have acknowledged rights and means to manage forests cooperatively and equitably. W2 = 30%</td>
</tr>
<tr>
<td>P3</td>
<td>The health of forest actors, cultures and the forest is acceptable to all stakeholders. W3 = 30%</td>
</tr>
</tbody>
</table>

Scoring and Analysis Guide for Assessing Human Well-Being
INTRODUCTION

Section I is the guide to scoring the criteria and indicators used in the assessment of human well-being. The scoring system is simple, with 1 reflecting the most unsustainable conditions and 10, the most sustainable. Examples or cases of conditions reflecting unsustainable conditions (1–3), medium levels of sustainability (4–6) and fairly good levels of sustainability (7–10) are presented to help assessors evaluate the conditions they confront.

Section II guides the user through the process of setting up spreadsheets, and developing the 'master spreadsheet' of C&I described in The BAG and The Grab Bag. The user is then guided through a series of steps, involving

1. judging the sustainability of (often qualitative) examples and case material;
2. assigning scores to each case/example (as evidence regarding a particular indicator);
3. averaging the scores for all the cases providing evidence relating to indicators for a particular criterion;
4. multiplying that average score by a weighting factor within the social C&I; and
5. averaging these values, determined for each criterion, to provide a value for the principle, and ultimately for the whole set of social C&I.

This procedure is simply a way to systematise and record your observations and judgements. It helps you remember what you have seen, helps keep you focused on the C&I of interest, and helps you identify gaps in your knowledge as you proceed through the assessment. There is nothing sacrosanct about the values you give or the averages you compute. They simply reflect your qualitative judgement, based
on systematic observation, about human conditions on the site. They are relative values, not absolute ones.

Section III provides guidance for those using the quantitative methods proposed in The BAG and The Grab Bag in the data analysis. It helps the assessor with computer use and statistics and facilitates the development of simple, descriptive tables and figures to help make an assessment. The manual focuses on the analysis of results from the following methods: CatPac, the Histo-Ecological Matrix, Access to Resources by Generation, Benefit Sharing among Stakeholders, and Rights to Manage the Forest. This section includes very basic instructions for those who have not had any experience with spreadsheets, through to more complex statistical analyses that can be conducted if the expertise, time and interest are available.
CIFOR’S ‘BEST BETS’ SET OF PRINCIPLES, CRITERIA AND INDICATORS FOR HUMAN WELL-BEING (BASED ON FIVE YEARS OF FIELD TESTING AROUND THE WORLD)

<table>
<thead>
<tr>
<th>P1</th>
<th>Forest management maintains or enhances fair intergenerational access to resources and economic benefits.</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1.1</td>
<td>Local management is effective in controlling maintenance of and access to the resource. ¹</td>
</tr>
</tbody>
</table>

| I1.1.1 | Ownership and use rights to resources (inter- and intragenerational) are clear and respect preexisting claims. |
| I1.1.2 | Rules and norms of resource use are monitored and enforced. |
| I1.1.3 | Means of conflict resolution function without violence. |
| I1.1.4 | Access to forest resources is perceived locally to be fair. |
| I1.1.5 | Local people feel secure about access to resources. |

| C1.2 | Forest actors have a reasonable share in the economic benefits derived from forest use. |

| I1.2.1 | Mechanisms for sharing benefits are seen as fair by local communities. |
| I1.2.2 | Opportunities exist for local and forest-dependent people to receive employment and training from forest companies. |
| I1.2.3 | Wages and other benefits conform to national and/or International Labor Organisation (ILO) standards. |
| I1.2.4 | Damages are compensated in a fair manner. |
| I1.2.5 | The various forest products are used in an optimal equitable way. |

| C1.3 | People link their and their children’s future with management of forest resources. |

| I1.3.1 | People invest in their surroundings (e.g., time, effort, money). |
| I1.3.2 | Outmigration levels are low. ² |
| I1.3.3 | People recognise the need to balance numbers of people with natural resource use. |
| I1.3.4 | Children are educated (formally and informally) about natural resource management. |
| I1.3.5 | Destruction of natural resources by local communities is rare. |
| I1.3.6 | People maintain spiritual or emotional links to the land. |

¹ This criterion is obviously very closely connected with criteria addressed from ecological and formal ‘forest management’ perspectives.

² Indicators 1.3.2 and 3.1.2 contain a potential contradiction. Low levels of outmigration (I1.3.2) indicate that people link their and their children’s futures to maintaining the forest; yet recognising the need to balance numbers of people with natural resource use (I3.1.2) may lead them to favour outmigration. This contradiction would likely occur when conditions are deteriorating.
<table>
<thead>
<tr>
<th>P2</th>
<th>Concerned stakeholders have acknowledged rights and means to manage forests cooperatively and equitably.</th>
</tr>
</thead>
<tbody>
<tr>
<td>C2.1</td>
<td>Effective mechanisms exist for two-way communication related to forest management among stakeholders.</td>
</tr>
<tr>
<td>I2.1.1</td>
<td>&gt; 50% of timber company personnel and forestry officials speak one or more local language, or &gt; 50% of local women speak the national language.</td>
</tr>
<tr>
<td>I2.1.2</td>
<td>Local stakeholders meet with satisfactory frequency, representation of local diversity, and quality of interaction.</td>
</tr>
<tr>
<td>I2.1.3</td>
<td>Contributions made by all stakeholders are mutually respected and valued at a generally satisfactory level.</td>
</tr>
<tr>
<td>C2.2</td>
<td>Local stakeholders have detailed, reciprocal knowledge pertaining to forest resource use (including user groups and gender roles) as well as forest management plans prior to implementation.</td>
</tr>
<tr>
<td>I2.2.1</td>
<td>Plans/maps showing integration of uses by different stakeholders exist.</td>
</tr>
<tr>
<td>I2.2.2</td>
<td>Updated plans, baseline studies and maps are widely available, outlining logging details like cutting areas and road construction, and include temporal aspects.</td>
</tr>
<tr>
<td>I2.2.3</td>
<td>Baseline studies of local human systems are available and consulted.</td>
</tr>
<tr>
<td>I2.2.4</td>
<td>Management staff recognises the legitimate interests and rights of other stakeholders.</td>
</tr>
<tr>
<td>I2.2.5</td>
<td>Management of NTFP reflects the interests and rights of local stakeholders.</td>
</tr>
<tr>
<td>C2.3</td>
<td>Agreement exists on rights and responsibilities of relevant stakeholders.</td>
</tr>
<tr>
<td>I2.3.1</td>
<td>Level of conflict is acceptable to stakeholders.</td>
</tr>
</tbody>
</table>
The health of forest actors, cultures and the forest is acceptable to all stakeholders.

<table>
<thead>
<tr>
<th>C3.1</th>
<th>There is recognisable balance between human activities and environmental conditions.</th>
</tr>
</thead>
<tbody>
<tr>
<td>I3.1.1</td>
<td>Environmental conditions affected by human uses are stable or improving.</td>
</tr>
<tr>
<td>I3.1.2</td>
<td>Immigration and/or natural population increases are in harmony with maintaining the forest.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C3.2</th>
<th>The relationship between forest management and human health is recognised.</th>
</tr>
</thead>
<tbody>
<tr>
<td>I3.2.1</td>
<td>Forest managers cooperate with public health authorities regarding illnesses related to forest management.</td>
</tr>
<tr>
<td>I3.2.2</td>
<td>Nutritional status is adequate among local populations (e.g., children’s growth conforms to international standards of height for weight; infant and &lt; 5-year mortality levels are low).</td>
</tr>
<tr>
<td>I3.2.3</td>
<td>Forest employers follow ILO work and safety conditions and take responsibility for the forest-related health risks of workers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C3.3</th>
<th>The relationship between forest maintenance and human culture is acknowledged as important.</th>
</tr>
</thead>
<tbody>
<tr>
<td>I3.3.1</td>
<td>Forest managers can explain links between relevant human cultures and the local forest.</td>
</tr>
<tr>
<td>I3.3.2</td>
<td>Forest management plans reflect care in handling human cultural issues.</td>
</tr>
<tr>
<td>I3.3.3</td>
<td>There is no significant increase in signs of cultural disintegration.</td>
</tr>
</tbody>
</table>

3 The fact that this indicator is not necessarily related to its criterion is one example of the shortcomings in this third principle, due to the absence — in contrast to the first two principles — of systematic field testing.
The Scoring Guide
I n the following pages, we begin with the principles, criteria and indicators that make up the CIFOR C&I template related to social issues. One of our assumptions has been that social issues are on an equal footing with ecological and production-related aspects of sustainability assessments. Within the social C&I, we have allocated weightings (percentages) to each principle; and we have divided the percentages for each principle into weightings by criterion. These weightings are listed in parentheses after each principle (total) and each criterion (proportion of the principle’s total). The weights are based on our team’s qualitative estimate of the weights, which in turn is based on our field experience testing the criteria and indicators and testing methods to assess them in various countries. It may be necessary to adjust weights based on different field contexts. We ask users to avoid considering these scores and weights to be in any way sacrosanct. Although they represent our best estimate of how to assess sustainability issues at this time, we readily acknowledge their imperfection and ask users to bear this in mind.

Following the section on how to score qualitative conclusions, we have a short section (II) showing how to create a master C&I spreadsheet — a device for keeping track of your case material, making sure that you address each indicator, and come to a final score for your assessment. We also provide examples of evidence or cases that have been scored.
The Criteria and Indicators Toolbox Series No. 7

I - THE SCORING GUIDE

P1  Forest management maintains or enhances fair intergenerational access to resources and economic benefits (Total value = 40%)

C1.1  Local management is effective in controlling maintenance of and access to the resource.4
(Weighting factor = 15%)

I1.1.1  Ownership and use rights to resources (inter- and intragenerational) are clear and respect pre-existing claims.

Score of 1–3
Different stakeholders consistently present different views of ownership regulations (e.g., the government and timber companies state that the forest belongs to them while local people consider them theirs).

Score of 4–6
Although there is some disagreement about specifics (particular species may be subject to conflict, or a few special areas), various stakeholders explain ownership and use rights in similar ways. There could be a differentiation of ownership/use rights by area, by season, or by product.

Score of 7–10
There appears to be virtually complete agreement, preferably legalised in some manner, about the various stakeholders’ ownership and use rights to local resources. Private ownership of land and/or plants, communal ownership, and various systems of use rights are among the options for such agreement and certainty to occur.

I1.1.2  Rules and norms of resource use are monitored and successfully enforced.

Score of 1–3
There may be no functioning rules and norms of resource use. Many examples of people disobeying local laws may be observed (e.g., people come in from other communities and harvest rattan in a community where permission is reportedly required; or outsiders hunt in local areas where local people reportedly have exclusive rights). No effective mechanisms for monitoring or enforcing local regulations appear to be in operation.

Score of 4–6
There are local rules and regulations, but they may conflict with other sets (e.g., local community vs. national government, or even confusion about regulations from conservation vs. logging components of the Ministry of Forestry). Assessors note occasional examples of people disobeying local laws but more examples of people obeying them, with some sense that the system is working. There is some evidence that there are monitoring mechanisms, though they don’t work perfectly. Sanctions are at least sometimes applied (incidents are observed of transgressors being caught, fined, put in jail, etc.).

4  This criterion is obviously very closely connected with criteria addressed from ecological and formal ‘forest management’ perspectives. Its weighting factor of 15 assumes additional points in other parts of the overall assessment.
Score of 7–10
Local rules and regulations are clearly defined and consistently applied. Assessors encounter no more than one recent example of people disobeying prevailing laws without punishment, and there is a feeling from local stakeholders that resource management is condoned and under control.

I1.1.3 Means of conflict resolution function without violence.

Score of 1–3
Many instances of conflict, including recurrent physical violence (burning down of timber camps, fighting among different stakeholders, threats), are reported and the assessors may witness some. There do not appear to be mechanisms for effectively dealing with conflict (courts don’t function; bribery is rife; no party can serve as an independent judge).

Score of 4–6
Although conflicts occur, including occasionally some violence, they are not prevalent. Mechanisms for conflict resolution, though imperfect, do function. Many cases can be satisfactorily resolved in the courts, by traditional legal means, or by negotiations among stakeholders.

Score of 7–10
Conflicts are rare, and when they do occur, are satisfactorily resolved. Mechanisms for conflict resolution are apparent and function smoothly and in a transparent manner.

I1.1.4 Access to forest resources is perceived locally to be fair.

Score of 1–3
All or certain stakeholders (especially forest actors) complain continually about unfair access to resources. There may also be groups who suffer obvious injustices silently. Inequity in access to resources is obvious to the outsider as well.

Score of 4–6
Although there is some inequity in resource distribution, most stakeholders consider the situation from marginally to reasonably acceptable. Conditions for workers and local people, for instance, may be considered to be better than they would be without the timber company.

Score of 7–10
Almost all people encountered accept access to resources is accepted as equitable by almost all people encountered. Various stakeholders can explain why access to resources functions as it does and agree that this is a reasonably good or even excellent distribution.
I1.1.5 Local people feel secure about access to resources.

**Score of 1–3**
People regularly express their fears, both for themselves and for their children, about their access to resources. They may consider that their land tenure or rights to forest products are on very 'shaky ground'. There may be national or regional plans to convert some of their area to some other use (plantations, transmigration, mining) from which they fear they will receive little or no benefit. Local people may feel the quality of the resources is declining so fast that there will be little left in the future.

**Score of 4–6**
Although people express some fear about the future, they are reasonably secure at the moment. There may be some threats, but either none seem terribly frightening, or people are uncertain of the implications of the threats. There is still a feeling of optimism, generally about current and future access to resources.

**Score of 7–10**
People freely express their feelings of security when asked about current and future access. They routinely plan for the future in that locale, including, for example, such activities as planting slow-growing trees. They may also show generosity in lending land or providing periodic access to their other resources. Rarely are fears expressed on this issue.

C1.2 Forest actors have a reasonable share in the economic benefits derived from forest use. (Weighting factor = 15%)

I1.2.1 Mechanisms for sharing benefits are seen as fair by local communities.

**Score of 1–3**
There are no identifiable mechanisms for sharing benefits, other than possibly some very minimal employment of local people. Local stakeholders consider forest resources to be exclusively available to certain, usually powerful/wealthy stakeholders. Local communities may have severely restricted or no access. Assessors hear recurrent complaints from various stakeholders about the unfairness of the current situation, and inequities are obvious (e.g., where a company comes in with governmental backing and forbids traditional forest uses).

**Score of 4–6**
There are some mechanisms for sharing of benefits, such as contributions by the company to community building efforts, community level development activities, and access to health care at the base camp. Although very substantial benefits from the forest go to the timber company (particularly monetary benefits), local people also derive benefits from the forest. They are able to continue their traditional agricultural activities (though with some uncertainty and lack of power in related negotiations), NTFP collection, and other forest uses in a way that is not seriously undermined by the timber company's activities.
Score of 7–10
The issue of benefit sharing has been considered by all local stakeholders, and a satisfactory division of benefits has evolved or been negotiated. Mechanisms may include formally acknowledged, intergenerational rights to particular areas of land or species, royalty payments from the company, recognition of intellectual property rights, ‘affirmative action’ for local communities in employment, etc.

I1.2.2 Opportunities exist for local and forest-dependent people to receive employment and training from forest companies.

Score of 1–3
Virtually all timber company employees come in from outside, and local people are denied access on a regular basis. The few who do gain employment are slotted into 'dead-end' jobs.

Score of 4–6
Although some timber company employees are brought in from outside, a sizeable percentage of local people have opportunities to work in the company. There is evidence that local people also can work up through the ranks. Some local people express interest in working in the company.

Score of 7–10
Special attention is given to making company employment opportunities available to local people first. Efforts are made by the company to attract local people (e.g., compromises may be made to accommodate the seasonal labour needs of local agroforestry). Local people can advance beyond low-level employment.

I1.2.3 Wages and other benefits conform to national and/or ILO standards.

Score of 1–3
Wages are lower than comparable work in other sectors in the area and lower than legal standards. Health and life insurance are not even considered. Neither are vacation, sick leave, or severance pay. Workers’ ‘contracts’ may be verbal understandings. There may be recurrent trickery or failures on the part of the company to abide by these informal agreements and understandings.

Score of 4–6
The logging company has rules specifying salary standards and benefits, and some are applied. However, there may be inadequate attention to these details or too little follow-up. Employees may not know the extent of their rights and benefits, either within the company or legally. If recompense is determined by cubic metres of wood cut, for instance, the workers may not know how to do the computations required to know what they are due. Workers hired through third-party contractors may have significantly less desirable salaries and benefits than those working directly for the company.

5 There is a potential conflict between this indicator and the concern to maintain the culture-forest link or cultural diversity. Sometimes involvement in wage labour such as that provided by timber companies results in alienation of people from their traditions without substituting anything better.
I - THE SCORING GUIDE

Score of 7–10
National or ILO standards are an explicit part of company policy and significant efforts are made to follow through on their implementation. Salaries and benefits are equal to or better than salaries given for comparable work by other employers in the area. Health and life insurance, sick leave and annual leave are routinely provided to company employees. New employees are informed of their rights in a transparent manner. Mechanisms exist for ensuring that other workers (under third-party contracts, for instance) also receive adequate salary and benefits.

I1.2.4 Damages are compensated in a fair manner.

Score of 1–3
The timber company regularly damages local property or injures local people without providing any compensation. These damages may include killing or injuring local people with trucks or speedboats, killing local trees while logging or building roads, building roads through sacred groves, pulling log rafts over fishing nets, dumping chemicals in local water supply. Companies may clear areas that local people have traditionally used for agriculture, and replant with some commercial species owned by the company, without recompense.

Score of 4–6
Although the logging company occasionally damages something belonging to the local people, there are clear mechanisms for compensating the owners. These mechanisms are the subject of some debate, but examples of reasonable compensation are not unusual. There may be outstanding disagreements that have not been satisfactorily resolved.

Score of 7–10
The logging company knows about local ownership and use rights, and rarely damages local property. When damage does inadvertently occur, there are transparent mechanisms for assessing and paying compensation. There are also conflict resolution mechanisms in case of disagreement about fair compensation.

C1.3 People link their and their children’s future with management of forest resources.
(Score = 10%)

I1.3.1 People invest in their surroundings (e.g., time, effort, money).

Score of 1–3
There is virtually no observable community cooperation in common goals (e.g., building churches/mosques, cleaning streets, and doing village projects). People are not taking good care of their own village, their own homes, their own possessions, or local natural resources. There is a sense that they might leave at any moment, without undue regret. If people seek education, it is in relation to seeking a different life elsewhere.
I - THE SCORING GUIDE

6 Indicators 1.3.2 and 3.1.2 contain a potential contradiction. Low levels of outmigration (I1.3.2) indicate that people link their and their children's future to maintaining the forest; yet recognising the need to balance numbers of people with natural resource use (I3.1.2) may lead them to favour outmigration. This contradiction would likely occur when conditions are deteriorating.

Score of 4–6
There is some community-organised activity, though it is marred by intra-community conflicts and some degree of free riding. Local people make investments in their own homes, and to a lesser extent in the community at large. They plant trees and other long-term crops. There is evidence that they are expecting to stay in the area.

Score of 7–10
The local communities are well organised and regularly engage in cooperative community projects. People have pride in their surroundings and make efforts to improve them. There is a considerable degree of building, decoration, and other improvements in the community. Young people are educated with the idea that they should return to improve their own surroundings.

Score of 1–3
There is an exodus of people from the area. Population figures are falling dramatically, primarily due to outmigration, and people encourage their children to look for better opportunities elsewhere.

Score of 4–6
People feel the call of 'city lights' for financial or other reasons, and some desire to escape the hardships of life in the forest, but most remain. Although parents perceive some advantages to city life, they tend to raise their children with the expectation that they will stay in the area and lead a forest-related life.

Score of 7–10
Very few people leave the area due to need or dissatisfaction with life there. Children are taught locally relevant skills and to value their way of life.

I1.3.2 Outmigration levels are low.

Score of 1–3
People reproduce at a high rate, creating a problem for their environment. Large family sizes are the norm, with most children remaining in the area and pursuing a lifestyle that depends on local natural resources. People do not recognise any link between number of people and the resource base.

Score of 4–6
Population sizes are growing somewhat, and there is some pressure on the natural resources, but the situation is not dire. People are aware of a connection between people and resource use, but few mechanisms exist to assure a balance. There may be few alternatives.
Score of 7–10
People explicitly state the importance of balancing natural resources with human population and land use. There are effective mechanisms to intensify land use and/or to stabilise population levels (e.g., effective family planning program; significant outmigration; development of local alternatives to natural resource dependence or more efficient use of resources).

I1.3.4 Children are educated (formally and informally) about natural resource management.

Score of 1–3
Adults have no relevant knowledge (including indigenous knowledge) about local natural resource management or they do not teach such knowledge to their children. In some cases, indigenous knowledge has been under-valued for decades, resulting in its loss or 'muting', and no formal educational process has been available.

Score of 4–6
The level of knowledge (indigenous, formal, or a combination of the two) is acceptable, and some mechanisms exist for passing on this knowledge. However, problems remain. Useful indigenous knowledge may not be recognised by the educated; inappropriate formal knowledge may have greater authority and thus be applied in harmful ways; time spent in formal education may take away from important informal mechanisms for transmitting indigenous knowledge.

Score of 7–10
Adults have significant knowledge about natural resources and their management and pass it to their children. The next generation is interested in learning and using the knowledge and recognises its value. Useful indigenous knowledge may be integrated into a formal educational program; there may be a meshing of the two kinds of knowledge; or either kind of knowledge about natural resource management may be passed on successfully to the next generation.

I1.3.5 Destruction of natural resources by local communities is rare.

Score of 1–3
Examples of destruction are commonly reported and occasionally seen during field visits. Young people may irresponsibly set fire to neighbouring areas; there may be grudge fires set by discontents; fishing with commercial poisons may be common; harvesting of forest products may be done in a careless way. Local people do not recognise the destruction as serious and/or they do not feel they can do anything about it.

Score of 4–6
Although destruction occasionally occurs, it is not common. Such destruction is recognised as a problem, and attempts (not always successful) are made to deal with the problem.

7 One caveat: In many humid tropical forest areas where swidden cultivation is the norm, fires set to clear forest for agricultural fields are part of a sustainable process, resulting in only temporary destruction that is part of a recurring cycle.
Score of 7–10
Destructive events are rare, and people maintain that destruction of natural resources is a bad thing. When people destroy things unnecessarily there are mechanisms for punishing them and for making amends.

I1.3.6 People maintain spiritual or emotional links to the land.

Score of 1–3
All spiritual links to (or other comparable links that motivate people to have a responsibility toward or sense of oneness with) the land have been destroyed (or have never existed). People see themselves as quite separate from the forest in which they live. They recognise no responsibility for the health of their forest.

Score of 4–6
Although spiritual links to the land and forests exist, they are often considered secondary to economic uses of the land and forests. There are some rituals that expressly link people to the land, but they may be dying out (in some cases, due to ridicule by outsiders or more powerful stakeholders). Or the people in the area may be newcomers who originated in a non-forested area.

Score of 7–10
The forest is seen as something of spiritual/cultural value and its maintenance is accepted as an important part of people’s lives. They recognise their dependence on it, and feel a sense of responsibility or stewardship toward it. Rituals and other evidence of this connection may be observable during fieldwork and/or can be described by local people. There is evidence of this value being passed down to younger generations.
P2. Concerned stakeholders have acknowledged rights and means to manage forests cooperatively and equitably. (Total value = 30%)

C2.1 Effective mechanisms exist for two-way communication related to forest management among stakeholders. (Weighting factor - 10%)

I2.1.1 > 50% of timber company personnel and forestry officials speak one or more local languages, or > 50% of local women* speak the language used by the timber company in local interactions.

Score of 1–3
Virtually no timber company personnel or forestry officials speak any of the local languages and almost none of the local people speak the language of the timber company personnel or the forestry officials.

Score of 4–6
Although an increasing number of stakeholders speak a common language, many still do not. This is particularly true of the women (who are less likely to speak national languages).

Score of 7–10
Virtually all local stakeholders share at least one common language.

I2.1.2 Local stakeholders meet with satisfactory frequency, representation of local diversity, and quality of interaction.

Score of 1–3
Members of different stakeholder/user groups rarely or never meet. Many express a reluctance to do so.

Score of 4–6
Communication occurs among a reasonably diverse set of local stakeholders (though women are likely to be drastically under-represented, as are certain disadvantaged ethnic groups), with some discomfort or tension. The process is not particularly easy.

Score of 7–10
There are numerous occasions in which various stakeholders voluntarily meet and discuss issues of relevance for forest management in the area. Such occasions include women and representatives of other marginalised groups (if they exist) interacting in a pro-active manner with other stakeholders. There is a sense of mutual respect among participants.

---

*Women’s language skills are a particularly good indicator since women are most often marginalised vis-à-vis local men in interaction with outsiders such as timber company personnel.
I2.1.3 Contributions made by all stakeholders are mutually respected and valued at a generally satisfactory level.

Score of 1–3
On the rare occasions when different kinds of stakeholders meet, their interaction is marked by social unpleasantness. One common pattern is disdain on the part of the timber company officials and fear or subservience on the part of the local community. Or there may be mutual disdain, fear, anger, distrust, and/or resentment, openly expressed.

Score of 4–6
Evidence of disrespect and antagonism remains in interactions among stakeholders (e.g., disdain from those in power; fear from those below), but there is also evidence that the less powerful can express and successfully negotiate some of their wishes. Stakeholders may express antagonism toward each other, but they qualify such expressions with some recognition of the contributions and rights of other stakeholders.

Score of 7–10
There is little evidence of negative attitudes by company officials and by community members and workers. Stakeholders freely express their mutual respect for each other. There may also be social movement of individuals from one stakeholder group to another.

C2.2 Local stakeholders have detailed, reciprocal knowledge pertaining to forest resource use (including user groups and gender roles), as well as forest management plans prior to implementation. (Weighting factor = 10%)

I2.2.1 Plans/maps showing integration of uses by different stakeholders exist.

Score of 1–3
The company’s plans and maps (if they exist) give no indication that there are any other stakeholders involved. They may have been created in some distant place, and no input from local stakeholders can be found. No mechanisms exist for gaining such input.

Score of 4–6
Plans and maps have been made locally with some input from local people. There may be incomplete representation of the many local uses of the forest, but some progress has been made in that direction. Local people can specify how that input occurred, and company officials can specify how they try to get such input.

Score of 7–10
Plans/maps available from the company clearly show the different local uses of the forest by various stakeholders. Mechanisms exist for regular updates.
I2.2.2 Updated plans, baseline studies and maps are widely available, outlining logging details such as cutting areas and road construction, and include temporal aspects.

Score of 1–3
No plans, baseline studies or maps pertaining to natural resource use are seen in the villages, in local offices, or on local walls or billboards.

Score of 4–6
Plans, studies and maps have been seen by local people, but rarely. Getting access to those resources is not always easy, or such information may be incomplete (showing cutting areas without a timeline, for instance).

Score of 7–10
Every village visited has recent and fairly complete information on the plans and activities of the timber company, and/or the people knew where to get and update such information easily.

I2.2.3 Baseline studies of local human systems are available and consulted.

Score of 1–3
There are no studies of local human systems in or near the timber company, and no timber company official has heard of any such studies.

Score of 4–6
The timber company has seen a few studies, and even conducted a few of its own (perhaps required by a government program). In some cases, those who conducted the studies may have been trained as foresters rather than social scientists, and the studies reflect a somewhat biased view of local people (often emphasising their ‘backwardness’ or ‘primitiveness’ or ‘low level of human resources capability’ rather than their indigenous knowledge or their potential contributions to natural resource management in the area).

Score of 7–10
The timber company office has a small library with information about the communities in the area and its own workers. These may include ethnographic studies, government and NGO reports, papers by scholars, consultants’ reports, etc. The available literature reflects a variety of perspectives, including positive attitudes toward local people.
I2.2.4 Management staff recognises the legitimate interests and rights of other stakeholders.

Score of 1–3
The management staff consistently insists on the company’s rights over and above those of any other stakeholders. Local people are seen as ‘encroachers’, ‘wild cutters’, ‘poachers’, and other derogatory names that reflect the view that local people do not have legitimate interests and rights in the area.

Score of 4–6
The management has recently begun to recognise that other stakeholders may have some interests and rights in the area, and they have begun to try to acknowledge those interests and rights. However, they regularly ‘back-slide’, using terms that reflect a less open view of forest management. They are also often tempted to refer to the laws of the country (which in many cases do not recognise the interests and rights of other stakeholders).

Score of 7–10
Most of the management staff express the idea that there are various stakeholders who have legitimate interests and rights in forest management. This perspective can be seen in the terms they use, the statements they make, and the literature they let the assessors read.

I2.2.5 Management of NTFPs reflects the interests and rights of local stakeholders.

Score of 1–3
The company’s management plans may contain no reference to NTFPs at all; or they may have rules that regulate their own use of NTFP, ignoring the uses of other stakeholders. There are no mechanisms to gain input from other stakeholders and no evidence of concern about the sustainability of NTFPs resources.

Score of 4–6
There is some attention in management plans to NTFPs, but there is incomplete coverage of local people’s uses. There may also be incomplete coverage of NTFPs (focusing only, for instance, on ones the timber company finds interesting). There may also be inadequate mechanisms for gaining input from all relevant user groups (particularly women or marginalised groups).

Score of 7–10
The company’s management plans have a clear discussion of NTFPs, with relevant rights and responsibilities. The sustainability of NTFP resources is addressed in the plan. There is obvious attention to the uses of other stakeholders, and there are mechanisms that show how that input is obtained from a variety of stakeholders.
C2.3 Agreement exists on rights and responsibilities of relevant stakeholders
(Weighting factor = 10%)

I2.3.1 Level of conflict is acceptable to stakeholders.

Score of 1–3
Conflict is frequent and acrimonious. Each stakeholder has a different story to tell about the latest problems with other stakeholders. People acknowledge that there is too much conflict, and express their inability to resolve it.

Score of 4–6
Conflicts about rights and responsibilities of different stakeholders are not uncommon. But the basis for the conflict is understood and the procedure for resolving the conflict is at least partially accepted. There may be some scepticism about different stakeholders’ actually performing their responsibilities and perhaps some suspicion that they are exceeding their rights.

Score of 7–10
There may be virtually no conflict. Or there may be some conflict, but with general agreement about rights and responsibilities to manage the forests. Conflicts are understood, and mechanisms exist to resolve them. All parties have adequate faith in these mechanisms.
P3. The health of forest actors, cultures and the forest is acceptable to all stakeholders. (Value = 30%)

C3.1 There is a recognisable balance between human activities and environmental conditions (Weighting factor = 10%).

I3.1.1 Environmental conditions affected by human uses are stable or improving.9

Score of 1–3
Natural resource use systems are in disrepair. For example, fallow cycles for shifting cultivation have been drastically reduced; Soil fertility and erosion problems are rampant; Fires frequently burn out of control; The level of production of forest products (NTFPs, fish, wildlife) has decreased dramatically in recent years; biodiversity is decreasing.

Score of 4–6
Natural resource use systems still function, but there are signs of potential problems. Lengths of fallows have been declining, though not precipitously. There may be some soil fertility and erosion problems emerging. People still harvest NTFPs (including fish and wildlife), but complain that there is less available to them than previously.

Score of 7–10
Natural resource use systems (particularly agriculture) are in good shape. Fallow cycles in shifting cultivation systems are long enough to maintain and/or improve soil fertility. Fires are successfully controlled at a level that local people consider good. Fishing and hunting success is good (equal to, or better than, in the past). Non-timber forest products are thriving to the same extent as previously (or better).

I3.1.2 Immigration and/or natural population increases are in harmony with maintaining the forest.

Score of 1–3
There have been dramatic influxes of migrants from other areas who plan to live by direct dependence on local natural resources; and/or there has been a dramatic increase in the rate of natural population increase, without alternatives to direct dependence on local natural resources. There are no official programs to grant people access to family planning methods, or to design subsistence strategies that do not rely directly on natural resources in the area.

Score of 4–6
Population levels are rising somewhat, and there is concern that local ‘carrying capacity’ may be exceeded (difficult as that concept is to define). People recognise a shortage of land for their agricultural needs, but conditions are not yet critical. There may be government and/or private industry plans to bring in additional families to the area (or spontaneous immigration), with some attention to population-land issues. Family planning may be available in some settings, but not in others; or there may be significant problems with acceptance of the idea for other reasons, though efforts continue to make it available.

9 These indicators are clearly closely linked to the ecological indicators, available elsewhere.
Score of 7–10
Population levels are stable and ‘in sync’ with the local environment; or successful alternatives to direct dependence on local natural resource use have been devised (successful intensification of agriculture, development of industry or tourism10). There is little concern about land availability for subsistence needs. Government and private industry’s plans for the area recognise and accommodate the need to balance human population with local resources. Family planning services are available and considered acceptable by local stakeholders.

C3.2 The relationship between forest management and human health is recognised.
(Weighting factor = 10%)

I3.2.1 Forest managers cooperate with public health authorities regarding illnesses related to forest management.

Score of 1–3
There is no contact between public health authorities and the timber company, in cases directly related to the company’s activities. Examples include 1) AIDS and other STDs are rampant due to sex ratio imbalances and resulting prostitution in logging camps, 2) the incidence of malaria and other mosquito-borne illnesses has increased due to bad logging practices (especially ponding and interference with the habitats of mosquito predators), 3) air pollution caused by field burning for the establishment of pulp and paper plantations has increased respiratory and ocular problems, 4) violent logging accidents are common, and/or 5) violence among workers from different ethnic groups characterise base camp life.

Score of 4–6
Public health authorities have some interaction with the timber company, though not much. The company provides some medical services to people in the area, but does not accept responsibility fully to monitor health problems related to logging activities. The company may take a very narrow view of its responsibility (e.g., only logging accidents); or it may do a rather uneven job of monitoring and notification. Significant, but not horrific, problems exist in terms of accidents, inter-ethnic violence, incidence of STDs, air and water pollution, and mosquito-borne diseases.

Score of 7–10
Public health authorities maintain records partially based on information provided by the logging company about the health of the people living in and near the forest; the company may support its own health clinics and provide medical coverage of others as well, particularly for health problems directly related to the company’s activities. The incidence of AIDS, STDs, malaria, dengue fever, violent accidents, and other illnesses/problems potentially related to logging activities is stable or decreasing.

10 The term ‘successful’ is important here, as most such attempts in tropical areas have not been successful.
I3.2.2 Nutritional status is adequate among local populations.

Score of 1–3
Diets may consist largely of starch and have inadequate variety and/or amounts. Obesity is regarded as attractive and desirable. Listlessness is common. There may be many examples of goiter, night blindness, chronic fatigue, and chronic illnesses such as malaria and tuberculosis. Children’s growth may be significantly lower than international standards of height for weight and/or children may have pot bellies and skinny arms. Infant and below-5’s mortality rates may be high. Women may be anaemic and show signs of calcium deficiency, especially during pregnancy.

Score of 4–6
Although there is generally enough food to eat, older people and the very young may be too thin. Apparently healthy active women may complain of aching bones during pregnancy. Teeth problems may be common in all ages (including complete loss at early ages). The local diet may be overly dependent on carbohydrates or contain too much sugar, caffeine and/or alcohol.

Score of 7–10
People can eat three meals a day, and their diet is varied (including all the important vitamins, minerals, protein and sources of energy). Most people appear healthy and strong. Intake of sugar, caffeine and/or alcohol is generally within healthy limits. Mortality and morbidity levels are low for all age groups.

I3.2.3 Forest employers follow ILO work and safety conditions and take responsibility for the forest-related health risks of workers.

Score of 1–3
Virtually no loggers are seen wearing protective clothing (hard hats, steel-toed boots, jeans, gloves); equipment is seen to be in poor working condition; safety guards and other safety features may have been removed from logging equipment; reckless driving of log trucks is obvious. The company managers and foremen do not appear concerned about safety. There are no safety training procedures or manuals in evidence. No medical care facilities are available at the base camp. Accidental injury or death is neither uncommon nor considered the responsibility of the company.

Score of 4–6
The company has safety regulations, but they are followed erratically. There is considerable individual choice about following safety regulations; and there is a fairly high accident rate. The company may accept responsibility for accidental injury and/or death, but may not consistently pay the recompense promised. There may be little or no formal training in safety precautions; and uneven provision of safety equipment, or uneven maintenance of equipment’s safety features. Minimal medical care is available at the base camp.
Score of 7–10
The company has a training program for all new employees and refresher courses for longer term employees focusing on safety. It supplies workers with safety equipment and specifies procedures for ensuring that equipment is regularly checked for safety and that workers' behaviour is monitored for compliance with safety regulations. Loggers are seen using protective clothing and safe, well maintained equipment. There are sanctions specified when people do not follow safety regulations. The company takes financial responsibility for accidental injury and/or death, by means of insurance or other mechanisms. The base camp has a fully operational clinic for dealing with severe injuries. Signs reminding workers about safety issues are visible in work settings.

C3.3 The relationship between forest maintenance and human culture is acknowledged as important. (Weighting factor = 10%)

I3.3.1 Forest managers can explain links between relevant human cultures and the local forest.

Score of 1–3
Company managers exhibit an obvious lack of interest in, and respect for, local people's culture (beliefs, norms, and customary behaviour). They tend to be noticeably ignorant of the ways of life of local people, often considering them backward or even disgusting. They may have no idea that local people have any knowledge of their forests.

Score of 4–6
Although there is some awareness on the part of company officials that local people have their own ways of life, and that there may be some positive elements to their cultures, this knowledge is very fragmentary. There may also remain a significant feeling about the inferiority of local people (due perhaps to their low level of wealth, power, or technological expertise). Openness to the involvement of local people in management may be limited to a very 'top-down' approach, in which the company 'calls the shots'.

Score of 7–10
Forest managers know how local traditional cultures work. They may be able to explain, for instance, the link between long fallows in the people's agroforestry system and soil regeneration. Or they may know the cosmological views of local people about the roles of particular species in the forest; taboos about entry into particular areas; and indigenous knowledge that local people have about wildlife behaviour and management. There is a widespread recognition among company officials that managing the forests sustainably will require drawing on the knowledge, values, and action of local people, as much as on that of other stakeholders.
I3.3.2 Forest management plans reflect care in handling human cultural issues.

Score of 1–3
Forest management plans include no compromise or recognition of the cultural uses of the forest by local people. Sacred groves, cemeteries, and areas set aside for future generations may be logged without consultation with local people. Company-supported areas of prostitution may be set up within community boundaries. Communities voice numerous complaints about the company’s behaviour.

Score of 4–6
There is some understanding and concern within the company about local cultural issues. Although management plans only partially incorporate such cultural issues, there is evidence that the company feels some obligation to address them. When problems arise, meetings do occur with local people to discuss recompense; but these are plagued by problems (e.g., the meetings happen after the area has been logged, the recompense offered is considered unfair, or promised recompense does not materialise).

Score of 7–10
Forest management plans are drawn up with a clear understanding of human cultural issues. There are transparent mechanisms for determining what important cultural issues may be affected by logging in the area, with additional mechanisms for updating of information and for conflict resolution. There is little evidence of frequent transgressions by the logging company.

I3.3.3 There is no significant increase in signs of cultural disintegration.

Score of 1–3
Thievery, prostitution, wanton destruction, and violent crime may be serious problems. Children may be abandoned or left unsupervised. People express confusion and ambivalence about their own values or profess none. Stress levels seem high, interest in life low. There may be extreme sex ratio imbalances. Cultural traditions and values fall by the wayside, or are possibly replaced by imitations of western ones, possibly picked up from television or other media; cultural values are not passed on to the younger generation.

Score of 4–6
There may be considerable inter-ethnic conflict, and some sex ratio imbalance. There may be some indications that traditional survival strategies are not fully functioning (perhaps because of an inordinate dependence on the timber company). Rituals and ceremonies continue but with less enthusiasm than previously.

Score of 7–10
Local systems of belief appear to remain integrated and functional. People of all generations express pride in their own way of life and their traditional value systems. Traditional rituals remain in evidence and their subsistence/economic system remains intact or exhibits incremental improvement.
The CIFOR C&I Toolbox Series includes two tools specifically devoted to social science methods for assessing human well-being. These tools, The BAG and The Grab Bag, are designed for assessors with various levels of expertise in social sciences, as is The Scoring and Analysis Guide. In this section, we lead users who lack experience in computer use or in social sciences, through the process of setting up an Excel spreadsheet for use in dealing systematically with qualitative and quantitative observations and results pertaining to the social C&I. We also provide examples of the kinds of evidence that you can use in supporting your assessment of human conditions, and ways conditions have been scored by several assessors in one location.

THE MASTER SPREADSHEET

The master spreadsheet is a mechanism for dealing systematically with the plethora of qualitative (and some quantitative) data that will emerge during the process of your assessment of human well-being. It is mentioned repeatedly in The BAG and The Grab Bag, as one way to systematize your observations. By beginning with an Excel spreadsheet\(^{11}\) listing the principles, criteria, and indicators, you can gradually fill in examples, cases, evidence, and other material that pertains to each of these issues.

Create a master spreadsheet such as that shown in Figure 1, showing all the social principles, criteria, and indicators in your list (e.g., CIFOR Generic C&I Template) in the first column (A). By inserting additional rows between each issue, you can insert full explanations of your case material, beginning in Column B (cf. Table 1), as you collect it. Table 1 is an adapted version of part of a master spreadsheet.

\(^{11}\) It is also possible to follow this procedure without benefit of a computer; it’s just simpler with one!
dealing with security of intergenerational access to resources (Colfer et al. 1996). In this summary example, cases from Danau Sentarum Wildlife Reserve (DSWR) in West Kalimantan were listed and scored. These are presented to give a 'real world' example of an assessment and the kinds of data that were recorded. You can later compile these cases into summary scores, for ease of presentation (as in Table 2, from the same source).

One important addition not included in Table 1 is the source of the information. The source might be 'personal observation at a wedding', 'a Punan man of about 30 years with a grade school education', or 'general discussion at an Iban women's meeting'. These sources can be entered below each case, beginning in Column C. The importance of including the source relates to your need subsequently to evaluate the veracity and potential bias of each bit of case material or evidence. After compiling a number of bits of information, you will assess (score) each case for its contribution to sustainability (using the scoring guide at the beginning of this manual).

Once you have assessed the sustainability value of each case, these scores can be averaged within each indicator to get an assessment for the indicator. Be alert in case there is evidence you consider particularly important or telling that may need extra weight in the assessment. You can follow the same process with indicators — averaging them to get an assessment for each criterion; and averaging the scores for criteria can yield an assessment for each principle.
You can obtain an overall average score on your spreadsheet by following this procedure:

1. judge the sustainability of your examples and case material;
2. assign scores to each case/example (as evidence regarding the indicators, as in Table 2);
3. average the scores for all the cases providing evidence relating to indicators for a particular criterion;
4. multiply that average score by a weighting factor within the social C&I (e.g., 15% for Criterion 1.1 ‘Local management is effective in controlling maintenance of and access to the resource’); and
5. average these values, determined for each criterion, to provide a value for the principle (e.g., P1 is weighted at 40% of the social C&I), and ultimately for the whole set of social C&I.

To get a score for the principle (1), ‘Forest management maintains or enhances fair intergenerational access to resources and economic benefits’, you would apply the following formula:

\[
\text{Score (C.1) x Weight (C.1) + Score (C.2) x Weight (C.2) + Score (C.3) x Weight (C.3)}
\]

Where the weights for C.1, C.2 and C.3 are 0.15, 0.15 and 0.1, respectively.
Criteria and indicators for human well-being, overall, are classified under three principles, with the following weightings:

<table>
<thead>
<tr>
<th>Principle</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Forest management maintains or enhances fair intergenerational access to resources and economic benefits.</td>
<td>W1 = 40%</td>
</tr>
<tr>
<td>P2</td>
<td>Concerned stakeholders have acknowledged rights and means to manage forests cooperatively and equitably.</td>
<td>W2 = 30%</td>
</tr>
<tr>
<td>P3</td>
<td>The health of forest actors, cultures and the forest is acceptable to all stakeholders.</td>
<td>W3 = 30%</td>
</tr>
</tbody>
</table>

To score the level of human well-being in the area you are assessing, you can simply average your scores, using this formula:

\[
\text{Human well-being} = [\text{P1(score)} \times W1] + [\text{P2(score)} \times W2] + [\text{P3(score)} \times W3]
\]

Where P1 = Principle 1 and W1 = the weighting factor for that principle.

It is important to remember that this procedure is simply a way to systematise and record your observations and judgements. It helps you remember what you have seen, helps keep you focused on the C&I of interest, and helps you identify gaps in your knowledge as you proceed through the assessment. As noted above, there is nothing sacrosanct about the values you give or the averages you compute. They simply reflect your qualitative judgement, based on systematic observation, about human conditions on the site. Their value is relative rather than absolute.
FIGURE 1.
Computer screen showing part of a Master C&I spreadsheet
(ex. Social Principle 2: ‘Concerned stakeholders have acknowledged rights and means to manage forests cooperatively and equitably’).

P.2. Concerned Stakeholders Have Acknowledged Rights and Means to Manage Cooperatively and Equitably

(G) 2.1. Effective mechanisms exist for two-way communication related to forest management among stakeholders

(g) 2.1.1. >50% of timber company personnel and forestry officials speak one or more local languages,
or >50% of local people speak the language used by the timber company in local interaction

(g) 2.1.2. Local stakeholders meet with satisfying frequency, representation of local diversity, and quality of interaction

(g) 2.1.3. The contributions of all stakeholders are mutually respected and valued at a generally satisfactory level
TABLE 1.
Sample listing of cases (on Social Principle 1: ‘Forest management maintains or enhances fair intergenerational access to resources and economic benefits’), with associated scoring, from Danau Sentarum Wildlife Reserve, 1996

In this table, (C) refers to Colfer and (W) to Wadley. Each indicator is numbered consecutively within each criterion. Numbered cases are presented under each indicator. Colfer and Wadley scored each case. Although Wadley saw Colfer’s scoring before he did his own, he made every effort to score according to his own views. These scores have been averaged by Indicator in Table 2.

1. Ng. Kedebu’, Bukit Rancong, and Danau Seluang residents have permission to reside in the Lakes area from their respective ‘mother villages’ on the Kapuas. None has been permanently inhabited for more than a few decades, and many residents of all three communities are seasonal. On the other hand, each community has its fairly clearly, albeit extra-legally, defined territory.
   C = 7; W = 7 (Melayu)

2. Wong Garai lost effective control over large portions of its traditional territories (see Figure 4). Its small numbers have not required constant use of the entire area, and its ethic of generosity has prompted them to allow others to settle on the land in the past. This reduction in territory is not accompanied by any sense of animosity toward the people now occupying that land, who are by and large relatives, or historically connected to the people of Wong Garai (i.e., not outsiders).
   C = 5; W = 5 (Iban)

3. In 1989, Wong Garai was able to save a significant tract of old growth forest from being logged. Wong Garai territory falls within the P.T. Militer concession, but the people appealed to the district and regional governments and received important help from one of its own who was a member of the regency legislature at the time. The forest was declared a protected area by the regency head (see Colfer and Wadley 1996).
   C = 7; W = 7 (Iban)

4. Kelayang residents gave permission some time ago for a Melayu community to reside on Kelayang land. The Melayu community has recently been trying to claim the land as its own, including making official requests to local government officials. So far Kelayang has been able to resist the claim. The Melayu community relates to the administrative boundaries of the modern district of which it is a part, whereas the Iban refer to their traditional system (old longhouse sites and cemeteries serve as evidence of their rights).
   C = 3; W = 3 (Iban; Melayu)

Our emphasis here is on local ownership and use rights, but we might add that there is considerable difference of opinion about actual rights to resources, with local people feeling the resources belong to them, and the Government considering the resources to belong to the Nation.
5. By 1996 Bemban, in co-operation with other Iban communities and their leaders in the district capital of Badau, had succeeded in persuading the managers of a plantation and a concession (both far along in the planning and early implementation stages by 1993) to abandon their plans to work in Bemban territory (partly related to local claims for compensation related to pulau, protected forest groves, and tembawai, previous longhouse sites).

\[ C = 6; W = 6 \] (Iban)

6. Bemban was legally defined as part of the Melayu community of Pulau Duri in 1989. Since that time, Pulau Duri has tried to convert to ownership its freely granted use rights in agricultural land in Bemban’s traditional area (lent to Pulau Duri on a long-term basis). So far Bemban has successfully resisted this attempt to confiscate part of its traditional area.

\[ C = 7 \] (Iban); \[ C = 2; W = 2 \] (Melayu)

(I) 1.2 Rules and norms of resource use are monitored and enforced

1. Ng. Kedebu residents expressed ‘righteous anger’ at other nearby communities whose members came and collected rattan or caught fish in their territory, contrary to Ng. Kedebu regulations.

\[ C = 7; W = 7 \] (Melayu)

2. A logging crew that had not asked permission was discovered in Bemban’s territory. On July 1, all the village men went together, first to Pulau Duri (where the official village headman lived) and then on to the camp in the forest, to question the intentions of the logging crew.

\[ C = 5; W = 5 \] (Iban)

3. A group of Bemban children and young women went out to the tembawai (previous longhouse site) to collect ferns for supper. They explained that only people from the community could collect ferns in this area. A young girl took the jackfruit Colfer was carrying, saying that Colfer might be fined for taking the fruit, whereas the girl herself was allowed to do so (see Sandin 1980).

\[ C = 8; W = 8 \] (Iban)

4. In 1994, residents of Wong Garai noticed members of another longhouse making moves to begin farming on Wong Garai’s lowland swamp forests. Although the other longhouse had been given limited swamp land in the past, some people were attempting to expand their holdings without permission. A hearing at Wong Garai was called, and a major dispute was avoided, with the other people withdrawing their intent to farm that forest (see Wadley 1997). Since then, people of Wong Garai have expressed their need and desire to preserve their lowland swamp forests for their own use in the future.

\[ C = 9; W = 9 \] (Iban)

13 Compensation was reportedly claimed and received in the amount of Rp. 20 million (roughly US$ 8500), based on losses of fruit trees, determined by adat (or local customary law).

14 Again, our emphasis is on local rules and regulations. But there is a host of rules and regulations from different parts of the Ministry of Forestry which are not normally monitored or enforced (e.g., the government forester who neither knew the regulations on timber harvesting nor who was supposed to enforce them; or Conservation Project personnel who manage the Wildlife Reserve but regularly ignore purple herons and storm’s storks tied to Melayu rafts, and macaques and small birds kept as pets by the Iban.

15 One impetus for this may be the ever-increasing threat of transmigration into the area down-river from Wong Garai — 200 families from Java.

Scoring and Analysis Guide for Assessing Human Well-Being 39
5. Occasionally during the early 1990s, the people of Wong Garai have been approached by outsiders requesting permission to search for *gaharu* or aromatic eaglewood (*Aquilaria* spp.), in Wong Garai forests. Invariably, and despite misgivings, the Iban have granted access to their forests, occasionally joining the search, with the promise of recompense (fees, sharing of harvest, or purchase). Also invariably, the community felt cheated, and complained amongst themselves (that some *gaharu* was hidden, or the work was harder than payments justified). Although this suggests naiveté on the part of the Iban to outsiders, it actually represents a deeply felt ethic of generosity and hospitality, making refusal extremely difficult (see Peluso 1994, Colfer *et al.* (1997), for a similar pattern among other Dayaks).

C = 4; W = 4 (Iban)

(I) 1.3 Means of conflict resolution function without violence

1. In the late 1980s, Wong Garai had a land dispute with a neighbouring longhouse. In years past, Wong Garai had allowed members of the other longhouse to farm land within Wong Garai territory, but later the other longhouse claimed the land as its own. It brought the case before the *temenggong* (traditional law leader) for a hearing, and the *temenggong* decided that the two disputants should divide the land. Wong Garai refused to accept the decision (which is locally agreed to be its right), arguing that the other longhouse has no *tembawai* (old longhouse sites) on Wong Garai territory which would mark its claim to the land. [See also (I)1.2, case 4]

C = 8; W = 8 (Iban)

2. Ng. Kedebu’ residents had frequent disagreements with P.T. Hutan Hebat, a timber company which regularly towed log rafts through Ng. Kedebu’ territory. One community member served as a tugboat pilot for the company, and also as an informal mediator in resolving these disputes. There was grumbling with regard to levels of compensation for damage to local fishing gear, but the system seemed to work.

C = 8; W = 8 (Melayu)

3. In 1994, several Iban merchants used large quantities of commercial pesticides to produce a major kill of fish for sale in Malaysia. This event killed hundreds of cages of fish which Ng. Kedebu’ (and other) community members kept as ‘savings accounts’ all along the Tawang River. Local ire was so great that the Conservation Project, local and regional government officials, the police, and the military got involved in resolving the dispute. Ultimately, all the communities in and around DSWR signed a pact not to use poison.

C = 4; W = 4 (Melayu)

4. Danau Seluang residents told a story from 1982–83, when Iban living up-river from Danau Seluang used fish poison eleven times. Each time the people complained and reported it to the authorities; no action was taken. This finally prompted the community itself to poison fish, in retribution. This in turn prompted governmental action, and resulted in a reduction in fish poisoning for a while.

C = 6; W = 6 (Iban, Melayu)

---

Wadley points out that there may have been conflicting perceptions of traditional use rights, with the Iban in question possibly considering this their right. Similar differences of opinion are possible in many of these cases.
(I) 1.4 Access to forest resources is perceived locally to be fair

1. In Ng. Kedebru’, logs had recently been quietly removed from passing P.I. Hutan Hebat log rafts. The logs were to be sawn into lumber and used to build a mosque. This action was agreed to by community members and justified with reference to the profits being gained by timber companies, vis-à-vis local benefits from local resources.

   C = 2; W = 2 (Melayu)

2. Forest fires occurred extensively in 1992 (the last really dry year) in Danau Seluang’s territory. This resulted in a significant reduction in the availability of rattan and timber, and losses connected with about 500 wooden tikung (bee hives), which serve as artificial bees’ nests. Burning was variously described as purposeful and related to outsiders’ envy or anger because they were denied permission to harvest; or entirely due to carelessness.

   C = 3; W = 3 (Melayu)

3. See also (I) 1.2, Case 5.

   C = 4; W = 4 (Iban)

4. Among the Melayu communities, use of jermal padat (a large fishing net) is considered unfair. The nets are large and expensive, and only a few residents have the means to buy them. Furthermore, they are efficient in catching fish, reducing the amount available for other fishers with access only to more labour-intensive fishing techniques.

   C = 2; W = 2 (Melayu)

(I) 1.5 Local people feel secure about access to resources

1. Wong Garai shares access to some forest and riverine land with another longhouse. There is some concern that this is leading to over-exploitation, particularly of riverine resources (e.g., fish). People are also concerned about their future ability to collect fish in the Lakes area during the dry season — something they have been doing for at least 150 years and to which they make traditional use claims — given the increasing presence of Melayu in traditional Iban use areas and the possibility that the government will begin to enforce its own very different boundaries in the future.

   C = 5; W = 5 (Iban)

2. In early 1994, the Wong Garai headman received a letter from the district office in Lubok Rian, explaining that there would be military people passing through the area doing a large mapping project for all the border districts. About a month later, soldiers came to Wong Garai territory, ferried in on helicopters to an open site some distance from the longhouse. The soldiers stayed for a few days in the forest, but never made contact with the longhouse. Wong Garai residents were upset about this as it is locally regarded as a breach of common courtesy. They viewed such lack of concern for proper etiquette as a sign of arrogance and as a reflection of their own powerlessness in the situation.

   C = 4; W = 4 (Iban)
3. Throughout the DSWR area, concern is expressed that others (e.g., timber companies, other ethnic groups, transmigrants) are encroaching on areas of traditional use, which could threaten the ability of community residents to use those resources in the future. For the Iban, the concern is more about their forest resources; whereas for the Melayu, the concern revolves around fisheries resources.

C = 4; W = 4 (Iban; Melayu)

4. In Bemban, Ng. Kedebu’, and Kelayang, many people expressed the conviction that they had recognised and legitimate rights to the areas and resources they were using — despite the presence of other stakeholders (especially the Conservation Project and timber companies) who were in competition for those resources.

C = 8; W = 8 (Iban; Melayu)

(C) 2: Forest actors have a reasonable share in the economic benefits derived from forest use

(I) 2.1 Opportunities exist for local people/forest-dependent people to get employment and training from forest companies

1. Very few residents within and around DSWR work for the timber concessions. Most workers are brought in from the outside. Kelayang is in the P.T. Panggau Libau concession, partially owned by Iban from the Lubok Rian area, some of whom are related to Kelayang residents. Although Kelayang economic involvement with this company is greater than that found between other companies such as P.T. Militer or P.T. Hutan Hebat) and local communities, there are still recurring conflicts (see Colfer and Wadley 1996). These include perceptions of inadequate employment opportunities, promised but unpaid rent on land, requests for rattan which is then not bought, and unfair recompense when a community member was killed by a company speedboat.

C = 3; W = 3 (Iban)

2. In Ng. Kedebu’, only one person is considered to have had a long-term relationship with the timber company. Young men occasionally work for a while with timber companies, but the perception of some people is that when fishing is good, the young men will leave the company. This may mean that incomes from fishing (and related economic endeavours) are better than incomes from the company.

C = 2; W = 2 (Melayu)

3. See also (I) 2.3, Case 1.

C = 2; W = 2 (Melayu)

(I) 2.2 Damages are compensated in a fair manner

1. In 1992, a sub-contractor with P. T. Militer/P.T. Hutan Hebat paid Bemban one portable, 500-watt generator for the right to harvest an unknown number of hectares in Bemban’s traditional area. Local people are becoming more astute, though they often lack power and voice in demanding justice.

C = 2; W = 2 (Iban)
(I) 2.3 Wages and other benefits conform to national and/or ILO standards

1. The workers Colfer spoke with — a mixture of locals and newcomers — considered themselves to be reasonably well paid, with reasonable benefits, working conditions, and safety standards. On the other hand, Wadley found that Iban who have worked for Indonesian logging companies generally complain about the low wages locally (compared to what they could earn for comparable work in Malaysia), the dangerous conditions, and poor equipment. Quite a few from Wong Garai had worked for P.T. Panggau Libau and said they had never been paid and would never work there again.

C = 2; W = 2 (Iban)

(I) 2.4 Fair mechanisms exist for sharing benefits with local communities

1. In Ng. Kedebu' and Bukit Rancong, there was a feeling that funds made available to the Conservation Project from eco-tourists and payment of salaries and other in-kind help from the project were unfairly distributed.

C = 2; W = 2 (Melayu)

2. Payment of royalties to local communities, in recognition of their prior rights, has been suggested by some as a mechanism for sharing benefits more fairly. No royalties are paid to DSWR communities or those in the surrounding area. Various taxes are paid by companies to the Kapuas-based forestry agent, but these go to Pontianak (and a proportion also goes on to Jakarta, cf. Ascher 1993).

C = 2; W = 2 (Melayu)

3. The Indonesian government requires that concessionaires implement HPH Bina Desa, or a 'village guidance' programme. This is designed to be carried out in a participatory manner, and can include income-generating projects, village structural improvements, agricultural improvements, and contributions to education, religion, or other community services (cf. Wentzel 1995). P.T. Panggau Libau (partially owned by local Iban — a situation unique in our experience) provided us with a listing of churches and schools it had built, teachers' salaries it had paid, and so on. Despite this, there were significant complaints about the company's activities, from Kelayang (see above; and from Wadley's previous work from other communities as well). Most people queried throughout the reserve and its surroundings had never heard of HPH Bina Desa; the responses of the few who had (one of the district officers, an official in a timber concession) made it clear that the activity level was minimal.

C = 4; W = 4 (Iban, Melayu)

(C) 3: People link their and their children's future with management of forest resources

(I) 3.1 People invest in their surroundings (time, effort, money, etc.)

1. Recent building of numerous schools and mosques in DSWR area.

C = 10; W = 10 (Melayu)

As with the perception of security of tenure, local workers may have different perceptions than outside assessors. Local working conditions would not, for instance, comply with those proposed by previous CIFOR teams, or with ILO standards.
2. Enforcement of local regulations to protect resources. For the Melayu, this involves protecting special areas such as fish nurseries; prohibiting small mesh sizes and harvesting of fish under certain size; restricting access to rattan or valuable wood; outlawing burning; and for the Iban, maintenance of special forest preserves (pulau) and old longhouse sites (tembawai), and the prohibition against farming the peaks of mountains to allow for forest regeneration of swiddens (see Wadley et al. 1996).

3. Increasing educational levels (with significant sacrifice and investment by both parents and children). This also has recognised and profound negative consequences, such as loss of traditional ecological land ritual knowledge, devaluing of traditional work and knowledge, and increased consumerism.

(I) 3.2 Outmigration levels are low

1. There is seasonal migration into the Reserve, primarily from residents along the Kapuas with kinship links to the communities within the Reserve. The close economic and kinship ties between Reserve communities and their ‘mother villages’ along the Kapuas would make control of this seasonal population increase difficult as well. Many of those who started as seasonal fishers in the Reserve have settled in and built permanent homes there. Many also express a commitment to staying and making their community better for their children.

2. Iban men are regular circular migrants to Malaysia, where they work for the higher wages available there. They normally return home, bringing welcome booty with them (often at harvest time).

3. Permanent outmigration does not appear to be common. There are numerous examples of young people who have gone away to school and returned; and middle-aged people who have gone away to work for a while but returned to contribute their new abilities and experience to their home community.

(I) 3.3 People recognise the need to balance numbers of people with natural resources

1. Birth control has been widely accepted — often linked to resource use issues. Iban women, however, recognising that families are better able to provide for fewer children, that they are freed from the real risk of death in pregnancy and childbirth, and that they can be more economically productive, worry that low or stable fertility levels among indigenous people like themselves may provide an excuse to move transmigrants into the area who may overwhelm them numerically.
2. There appears to be considerable immigration into the Reserve, with no effort or means to control it. Indeed, there is an ethic of hospitality which would make such control difficult without outside support.

C = 3; W = 3 (Melayu)

3. See also (I) 3.2.

(I) 3.4 Children are educated (formally and/or informally) about natural resource management

1. Selection by parents of a variety of disciplines for their children to pursue (within one family) with the expectation that when the children return home, such knowledge will be available to the family and community from which they come. We met a number of examples of young people who did just that.

C = 5; W = 5 (Iban)

2. The Iban have a still-functioning system of land tenure and tree ownership rules and practice (see Wadley 1997), and maintain many rituals connected to farming. But they fear these ‘old ways’ — the ritual chants, the rich ceremonial language, and farming and forest knowledge — are being lost in the youth. Competition from national education and television is constant. In June 1996, for example, a set of important longhouse rituals was being performed at 1 a.m. (making of offerings, chanting of invocations to ancestor gods). At the same time, the young people had set up a stereo system to play Indonesian pop music at high volume, to which they ‘disco-ed’ at the other end of the longhouse. The resources of cultural and ecological knowledge (integral to sustainable management) which their immediate and distant ancestors have acquired were being lost.

C = 4; W = 5 (Iban)

(I) 3.5 Destruction of natural resources by local communities is rare.\(^{18}\)

1. Recurrent poisoning of fish with commercial pesticides, largely by a minority of Iban merchants, but also by some Melayu.

C = 4; W = 4 (Iban; Melayu)

2. Use of jermal padat, by a few comparatively wealthy Melayu (under a schizophrenic government policy).

C = 3; W = 3 (Melayu)

3. Perceived over-harvesting of swamp forest (rawa) by local people — current supplies of species available to local people are significantly reduced (tembesi', kawi, kelansau, medang, menyawai'). [Those used by Melayu are mostly swamp species.]

C = 5; W = 5 (Melayu)

\(^{18}\) Other C&I will have to deal with destruction by other stakeholders (e.g., harvesting of timber by concessionaires without regard to regulations; transmigration of large numbers of families into already occupied forest areas; conversion of natural forest areas to industrial timber estates or oil palm/rubber plantations).
(I) 3.6 People maintain spiritual links to the land

1. During Colfer's brief stay in Kelayang, three resource-related religious ceremonies were observed, all of which included the active involvement of the young (one to 'feed' a crocodile spirit in the river whose hunger had been revealed in a dream to constitute a threat to a community member; one to 'feed' the soil before beginning to clear a rice field; and one to 'feed' the soil in preparation for planting).
   \[ C = 10; W = 10 \] (Iban)

2. Strong sense of history and location (among the Iban) and an explicitly stated sense of responsibility to provide for children, grandchildren, and subsequent descendants.
   \[ C = 8; W = 8 \] (Iban)

3. Iban refer to the forest as seput menoa — 'the breath of the land', and recognise the hydrological consequences of too much forest cutting — e.g., drying up of water sources19 (see Wadley et al. 1996).
   \[ C = 8; W = 8 \] (Iban)

4. Ng. Kedebu' parents express their sense of responsibility to their descendants, including expressions of concern about the sustainability of resources that are important to their lifestyle (timber, fish, rattan, bees).
   \[ C = 5; W = 5 \] (Melayu)

---

19 This hydrological knowledge has a spiritual component in that Iban contend that if they do not take care of the land both ecologically and ritually, it and they will become threatened with supernatural 'heat' (angat) which manifests itself in people's health and in social disruption.
### TABLE 2.
Scoring of C&I on Security of Intergenerational Access to Resources*  
(Colfer, Wadley, and Harwell)

<table>
<thead>
<tr>
<th>Cases/Evidence</th>
<th>Iban</th>
<th>Melayu</th>
<th>Average</th>
<th>Iban</th>
<th>Melayu</th>
<th>Harwell</th>
<th>Average</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>(C)1: Local management is effectively in controls of maintenance of, and access to, the resource</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(I) 1.1 Ownership/use rights to res. (inter/intragenerational) clear, respect… claims1</td>
<td>5.60</td>
<td>5.25</td>
<td>8.00</td>
<td><strong>6.28</strong></td>
<td>4.00</td>
<td>4.00</td>
<td>4.00</td>
<td><strong>5.30</strong></td>
</tr>
<tr>
<td>(I) 1.2 Rules and norms of resource use are monitored and enforced2</td>
<td>6.50</td>
<td>6.50</td>
<td>7.50</td>
<td><strong>6.83</strong></td>
<td>5.50</td>
<td>5.50</td>
<td>4.50</td>
<td><strong>5.17</strong></td>
</tr>
<tr>
<td>(I) 1.3 Means of conflict resolution function without violence3</td>
<td>6.00</td>
<td>6.00</td>
<td>8.00</td>
<td><strong>6.67</strong></td>
<td>5.00</td>
<td>5.00</td>
<td>4.00</td>
<td><strong>4.67</strong></td>
</tr>
<tr>
<td>(I) 1.4 Access to forest resources is perceived locally to be fair4</td>
<td>4.00</td>
<td>4.00</td>
<td>5.00</td>
<td><strong>4.33</strong></td>
<td>2.33</td>
<td>2.33</td>
<td>3.00</td>
<td><strong>2.56</strong></td>
</tr>
<tr>
<td>(I) 1.5 Local people feel secure about access to resources5</td>
<td>5.25</td>
<td>5.25</td>
<td>4.00</td>
<td><strong>4.83</strong></td>
<td>6.00</td>
<td>6.00</td>
<td>4.00</td>
<td><strong>5.33</strong></td>
</tr>
<tr>
<td><strong>(C)2: Forest actors have a reasonable share in the economic benefits derived from forest use</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(I) 2.1 Local people get employment and training from forest companies6</td>
<td>3.00</td>
<td>3.00</td>
<td>2.00</td>
<td><strong>2.67</strong></td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td><strong>2.00</strong></td>
</tr>
<tr>
<td>(I) 2.2 Damages are compensated in a fair manner7</td>
<td>3.50</td>
<td>3.50</td>
<td>3.00</td>
<td><strong>3.33</strong></td>
<td>3.00</td>
<td>3.00</td>
<td><strong>3.00</strong></td>
<td></td>
</tr>
<tr>
<td>(I) 2.3 Wages and other benefits conform to National and/or ILO standards8</td>
<td>2.00</td>
<td>2.00</td>
<td>3.00</td>
<td><strong>2.33</strong></td>
<td>3.00</td>
<td>3.00</td>
<td><strong>3.00</strong></td>
<td></td>
</tr>
<tr>
<td>(I) 2.4 Fair mechanisms exist for sharing benefits with local communities4</td>
<td>4.00</td>
<td>4.00</td>
<td>2.00</td>
<td><strong>3.33</strong></td>
<td>2.67</td>
<td>2.67</td>
<td>2.00</td>
<td><strong>2.44</strong></td>
</tr>
<tr>
<td><strong>(C)3: People link their and their children’s future with management of forest resources</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(I) 3.1 People invest in their surroundings (time, effort, money, etc.)9</td>
<td>8.00</td>
<td>8.00</td>
<td>8.00</td>
<td><strong>8.00</strong></td>
<td>8.00</td>
<td>8.67</td>
<td>4.00</td>
<td><strong>6.89</strong></td>
</tr>
<tr>
<td>(I) 3.2 People recognise need to balance no. people with natural resources10</td>
<td>6.63</td>
<td>6.63</td>
<td>7.00</td>
<td><strong>6.56</strong></td>
<td>5.00</td>
<td>5.00</td>
<td>2.50</td>
<td><strong>4.17</strong></td>
</tr>
<tr>
<td>(I) 3.3 Children educated (formally and/or informally) about nat. res, mgmt11</td>
<td>6.00</td>
<td>6.00</td>
<td>4.00</td>
<td><strong>5.34</strong></td>
<td>4.00</td>
<td>4.00</td>
<td><strong>4.00</strong></td>
<td></td>
</tr>
<tr>
<td>(I) 3.4 Destruction of natural resources by local communities is rare12</td>
<td>4.00</td>
<td>4.00</td>
<td>5.00</td>
<td><strong>4.33</strong></td>
<td>4.00</td>
<td>4.00</td>
<td>5.00</td>
<td><strong>4.33</strong></td>
</tr>
<tr>
<td>(I) 3.5 People maintain spiritual links to the land13</td>
<td>8.67</td>
<td>8.67</td>
<td>9.00</td>
<td><strong>8.78</strong></td>
<td>5.00</td>
<td>5.00</td>
<td>3.00</td>
<td><strong>4.33</strong></td>
</tr>
</tbody>
</table>

*Colfer, Wadley, and Harwell*
The wording may differ slightly because the field test took place in 1996; and summing and averaging a few of the indicators in the
previous table will not get precise same averages, because we have removed references to cases that were in boxes in Colfer and
Wadley’s original text.

1 Based on average scores (Colfer, Wadley) for 6 cases (see Table 1)
2 Based on average scores (Colfer, Wadley) for 5 cases (see Table 1)
3 Based on average scores (Colfer, Wadley) for 4 cases (see Table 1)
4 Based on average scores (Colfer, Wadley) for 3 cases (see Table 1)
5 Based on average scores (Colfer, Wadley) for 2 cases (see Table 1)
6 Based on average scores (Colfer, Wadley) for 1 case (see Table 1)
7 Harwell scored criteria and indicators, but not cases.

The fact that the forests in and around DSWR are in comparatively good condition suggests that these scores may be high, on a global
scale. The low average score for criterion 2 (2.5) suggests a possible flashpoint; and indeed feelings of unfairness about local people’s
share in forest benefits (that they felt should be their own) were both a recurring complaint and a rationale for examples of violent
confrontation. Our comparatively high assessment of the strength of their feelings of security about access to resources (7) and their
clear conceptual link between their own and their children’s well-being and the forests (5.4) seems likely to contribute to sustain-
ability by: a) confirming their ‘stake’ in the forest, and b) providing motivation for protecting it against potentially destructive new
endeavours in the area.
III Quantitative Analysis Guidelines
The Quantitative Analysis Guidelines are designed to help users interested in analysing the data derived from the quantitative methods available in The BAG and The Grab Bag. In this section, we provide detailed guidance on the use of computer spreadsheets, simple descriptive data analysis, and an introduction to more complicated statistical tests. Given the different levels of computer literacy that we have encountered within our own tests of assessment methods for social C&I, we concluded that ‘starting simple’ was the safest route. If you are already familiar with computer spreadsheets, you may want to skip over much of the following material. On the other hand, if you are a relatively new computer user, we hope these instructions will be helpful.

A – ANALYSIS OF RESULTS FROM A STAKEHOLDER IDENTIFICATION METHOD (CATPAC)

CatPac is a software package that uses neural network analysis to identify clusters in human speech. Most communications experts consider human speech to reflect human thought. CatPac has been used, in the context of assessment of human well-being in forests, to identify relevant stakeholders in forests in Cameroon, Indonesia and Brazil. Instructions on using the method are available in The Grab Bag. This manual deals only with analysis of the results.

CATPAC GUIDELINES

This section describes, for the new CatPac user, how to enter the text/data, some of the computer-related features requiring decisions, and how to make the dendograms and cognitive maps that comprise CatPac results.

a. How to enter the text/data
   • After you record the interview, the next step is entering the

20 There is a CatPac User Manual by Woelfel (1998). The manual contains more comprehensive information on this software. The purpose of our guidelines is only to give you the most crucial procedures in running CatPac.
text. You can enter the text using any Word Processing software, but remember to press Enter at the end of each line. This is to keep the text in a readable format\textsuperscript{21} when you open the text using the CatPac software.

- After you finish entering the text from one participant, type a ‘–1’ as a separator between participants. Be sure to enter the data from one category (men/women, different ethnic groups, occupation, etc.) in one file.

- Save the file in text format (*.txt). CatPac can only open text files.

b. How to choose the appropriate clustering method

All the clustering techniques provided by CatPac are based on an agglomerative method. There are no exact rules to choose. To know more about the advantages and disadvantages of each method, you can go to the Option menu, and then choose Clustering method. A dialogue menu will prompt you. Choose Help if you want to know more about each clustering method.

c. How to make an exclude file

Since you are interested in the clustering of significant words/concepts, you will likely want to exclude from your analysis certain grammatical and other words (such as ‘is’, ‘very’, ‘it’). CatPac has a default exclude file\textsuperscript{22} in English. In many cases this will not help you much, since most interviews should be in the local language. In that case, you have to set up an exclude file for that language. For initial purposes, you can translate the English file and use the translation as the new exclude file. You can do it by retrieving the English version file, translating the words line by line, and then saving

\textsuperscript{21} Many of our collaborators found the text that they already entered became a single long line of text when they opened the text file in the CatPac software. It occurred because they did not press Enter at the end of each line.

\textsuperscript{22} A file that contains a list of words appearing in the text of your interviews that have a primarily grammatical meaning, and do not contribute significantly to understanding of concepts related to the study.
them in another file with *.exc extension. It will perhaps be easier to imagine comparable grammatical markers in the local language and list them in the exclude file. If you find there are more irrelevant words that need to be excluded, you can add them to the list, by appending them at the bottom of your new exclude file.

d. How to make a dendogram
A dendogram is a figure representing the cognitive clusters of concepts, based on the speech (or text) you have entered and analysed. It normally looks something like a glove (see example below).

• Open the exclude file first, to activate the file. The exclude file will not be active unless you open it. Then open the text file that you want to analyse. You can use the default setting for options, including window size, slide size, clamping, clustering technique, etc. 23

• Go to the File menu and choose Run, and then choose Make dendogram. CatPac will give you the results in a few seconds. You can print the dendogram directly by choosing Print under the File menu. You also can save the dendogram as *.den file by choosing Save As under the File menu (see Dendogram sample below).

23 The use of each option and how to choose the right option for your text can be found in the CatPac User Manual.
### DENDOGRAM SAMPLE

**TOTAL WORDS**: 96  
**TOTAL UNIQUE WORDS**: 25  
**TOTAL EPISODES**: 101  
**TOTAL LINES**: 27

---

#### DESCENDING FREQUENCY LIST

<table>
<thead>
<tr>
<th>WORD</th>
<th>FREQ</th>
<th>PCNT</th>
<th>FREQ</th>
<th>PCNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>FORÊT (forest)</td>
<td>25</td>
<td>26.0</td>
<td>94</td>
<td>93.1</td>
</tr>
<tr>
<td>SAUVAGES (wild)</td>
<td>8</td>
<td>8.3</td>
<td>48</td>
<td>47.5</td>
</tr>
<tr>
<td>DONNE (give)</td>
<td>5</td>
<td>5.2</td>
<td>34</td>
<td>33.7</td>
</tr>
<tr>
<td>MANGUES (mango)</td>
<td>4</td>
<td>4.2</td>
<td>27</td>
<td>26.7</td>
</tr>
<tr>
<td>MIEL (honey)</td>
<td>4</td>
<td>4.2</td>
<td>31</td>
<td>30.7</td>
</tr>
<tr>
<td>NKONO</td>
<td>4</td>
<td>4.2</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>NOYAUX (pits)</td>
<td>4</td>
<td>4.2</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>TROUVE (find)</td>
<td>4</td>
<td>4.2</td>
<td>36</td>
<td>35.6</td>
</tr>
<tr>
<td>ANIMAUX (animals)</td>
<td>3</td>
<td>3.1</td>
<td>21</td>
<td>20.8</td>
</tr>
<tr>
<td>IGNAMES</td>
<td>3</td>
<td>3.1</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>MANGER (to eat)</td>
<td>3</td>
<td>3.1</td>
<td>21</td>
<td>20.8</td>
</tr>
<tr>
<td>MOABI [a tree]</td>
<td>3</td>
<td>3.1</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>MOI (me)</td>
<td>3</td>
<td>3.1</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>PARTIE (part)</td>
<td>3</td>
<td>3.1</td>
<td>9</td>
<td>8.9</td>
</tr>
<tr>
<td>CHOSE (thing)</td>
<td>2</td>
<td>2.1</td>
<td>10</td>
<td>9.9</td>
</tr>
<tr>
<td>MANGUIERS</td>
<td>2</td>
<td>2.1</td>
<td>10</td>
<td>9.9</td>
</tr>
<tr>
<td>NÉS (born)</td>
<td>2</td>
<td>2.1</td>
<td>13</td>
<td>12.9</td>
</tr>
<tr>
<td>SE [reflexive, self]</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>VIANDE (meat)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>VIE (life)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>VIS (lives)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>VIVRE (to live)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>ANCÊTRES (ancestors)</td>
<td>1</td>
<td>1.0</td>
<td>7</td>
<td>6.9</td>
</tr>
<tr>
<td>AUCUN (none)</td>
<td>1</td>
<td>1.0</td>
<td>7</td>
<td>6.9</td>
</tr>
</tbody>
</table>

---

#### ALPHABETICALLY SORTED LIST

<table>
<thead>
<tr>
<th>WORD</th>
<th>FREQ</th>
<th>PCNT</th>
<th>FREQ</th>
<th>PCNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANCÊTRES</td>
<td>1</td>
<td>1.0</td>
<td>7</td>
<td>6.9</td>
</tr>
<tr>
<td>ANIMAUX</td>
<td>3</td>
<td>3.1</td>
<td>21</td>
<td>20.8</td>
</tr>
<tr>
<td>ANIMAUX (animals)</td>
<td>3</td>
<td>3.1</td>
<td>21</td>
<td>20.8</td>
</tr>
<tr>
<td>ANIMAUX (animals)</td>
<td>3</td>
<td>3.1</td>
<td>21</td>
<td>20.8</td>
</tr>
<tr>
<td>ANIMAUX (animal)</td>
<td>3</td>
<td>3.1</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>AUCUN (none)</td>
<td>1</td>
<td>1.0</td>
<td>7</td>
<td>6.9</td>
</tr>
<tr>
<td>CHOSE (thing)</td>
<td>2</td>
<td>2.1</td>
<td>10</td>
<td>9.9</td>
</tr>
<tr>
<td>MANGUIERS</td>
<td>2</td>
<td>2.1</td>
<td>10</td>
<td>9.9</td>
</tr>
<tr>
<td>MANGUIERS</td>
<td>2</td>
<td>2.1</td>
<td>10</td>
<td>9.9</td>
</tr>
<tr>
<td>MANGER (to eat)</td>
<td>3</td>
<td>3.1</td>
<td>21</td>
<td>20.8</td>
</tr>
<tr>
<td>MOABI [tree]</td>
<td>3</td>
<td>3.1</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>MOBI</td>
<td>3</td>
<td>3.1</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>MOI (me)</td>
<td>3</td>
<td>3.1</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>NKONO</td>
<td>4</td>
<td>4.2</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>NÉS (born)</td>
<td>2</td>
<td>2.1</td>
<td>13</td>
<td>12.9</td>
</tr>
<tr>
<td>PARTIE (part)</td>
<td>3</td>
<td>3.1</td>
<td>9</td>
<td>8.9</td>
</tr>
<tr>
<td>PRODUITS (products)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>SE [reflexive, self]</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>VIANDE (meat)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>VIE (life)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>VIS (lives)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>VIVRE (to live)</td>
<td>2</td>
<td>2.1</td>
<td>14</td>
<td>13.9</td>
</tr>
<tr>
<td>FORÊT (forest)</td>
<td>25</td>
<td>26.0</td>
<td>94</td>
<td>93.1</td>
</tr>
<tr>
<td>MANGUES (mango)</td>
<td>4</td>
<td>4.2</td>
<td>27</td>
<td>26.7</td>
</tr>
<tr>
<td>MIEL (honey)</td>
<td>4</td>
<td>4.2</td>
<td>31</td>
<td>30.7</td>
</tr>
<tr>
<td>NKONO</td>
<td>4</td>
<td>4.2</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>NOYAUX (pits)</td>
<td>4</td>
<td>4.2</td>
<td>28</td>
<td>27.7</td>
</tr>
<tr>
<td>TROUVE (find)</td>
<td>4</td>
<td>4.2</td>
<td>36</td>
<td>35.6</td>
</tr>
</tbody>
</table>

---

**WARDS METHOD**
Interpretation: These data provide you with a visual expression of the clustering of words in the recorded text. The importance of these clusters derives from the perspective that people’s speech reflects their thoughts, to a certain degree. So if, for instance, the word ‘forest’ and ‘good’ appear together frequently (forming a cluster), we might conclude that these people consider forests to be good, which one might interpret to favour sustainability. In the above example, the French words for thing (chose), give (donné), forest (forêt), honey (miel), and me (moi) represent the most important cluster.
This suggests an important role of honey in local forest management. Pits (noyaux) and moabi (a Cameroonian tree) are in another important cluster close to the previous one, suggesting that these may be important forest products that people use. The clustering of words in people’s speech about a topic such as forests (or any other researchable issue) gives important hints about relations between forest and other elements in the local environment, human and otherwise.

e. How to make a cognitive map from CatPac

- CatPac also has the ability to produce a cognitive map. You can get the cognitive map by saving the dendogram file as a coordinate file (*.crd). You will be prompted by a dialogue box. Just click OK and type the name of your coordinate file.

- You can open the Thought View software, then open the coordinate file. You can do some operations on the picture (i.e., rotate the picture; shrink or enlarge; change the cube, grid, or font colour, etc.).

- After you are satisfied with the appearance of the picture, you can copy and paste it to another software by choosing Copy (Ctrl+Ins) under the Edit menu. You can see a sample of a cognitive map below.

---

24 The cognitive map can be used to help interpret the clusters. Most of the time, the cognitive map gives the same configuration as the dendogram, but sometimes it may provide new insights. If the results given by the two methods are conflicting, it is strongly recommended to use the results from the dendogram as they are more accurate.

25 Thought View is a complementary program for CatPac. You can install Thought View by clicking Setup.exe file in CatPac CD attached and following the instruction.
The cognitive map is sometimes useful to get a rough visual representation of people’s thinking. Again, you can see the close connections among the words honey (miel), me (moi), thing (chose), and give (donne). Forest (forêt) appears further away than one might guess from the cluster analysis. Toward the bottom of the plot the two unreadable terms are pits (noyaux) and moabi (a valuable Cameroonian tree).
B – ANALYSIS OF METHODS ON SECURITY OF INTERGENERATIONAL ACCESS TO RESOURCES

This section contains analytical guidance for three social science assessment methods: the HistoeCological Matrix, Access to Resources by Generation, and Benefit Sharing among Stakeholders. These methods have been found useful in assessing security of intergenerational access to resources in certain forests among certain groups of people.

1. HISTO-ECOLOGICAL MATRIX GUIDELINES

a. Entering the data

You can follow the format as shown in Figure 3. The resources identified in the field are listed across the top (palm, beef, egusi), while the years are listed vertically. You do not have to enter the data in consecutive years. We would, however, suggest you do so for ease of reading.

![Spreadsheet format for histo-ecological data](image)

FIGURE 3. Spreadsheet format for histo-ecological data
b. Checking linear trend over time
You can determine whether the data show a trend over time by using the regression facility in Excel. Add the regression command into Excel by installing its Add-Ins program.

Follow these steps to install the program:

- Go to the Tools menu and choose Add-Ins (Figure 4),

Click on Analysis ToolPak and Analysis ToolPak-VBA (Figure 5). Do not click the options if they are already marked, which means the Add-Ins program has already been installed on your computer.
After you install this program, you will see there is a new sub menu under the Tools menu, that is: Data Analysis, at the bottom of the Tools menu. You can do a regression analysis now by choosing the Data Analysis sub menu.

A dialogue menu as shown in Figure 6 will prompt you. Choose the regression option from the list of analysis tools and then click OK (Figure 6).
The next step is defining the range (the 'cells' in the spreadsheet that contain the data) for dependent variable (Y) and independent variable (X). Input the cell's range in a dialogue menu as shown in Figure 7. For instance, if you want to check the trends on palms, in the example above you can treat the palms variable as the dependent variable and year (time) as the independent variable. Do not forget to click on Residual plot, Line Fit Plot, and Normal Probability Plot, as you will need them later to check the model's adequacy. Then, click OK.
The output of the analysis that you will get is shown in Figure 8. You can check the model’s significance by looking at the p-value (shown by the arrow). If the p-value falls below 5% (0.05), it can be concluded that there is a linear trend over time. The line’s slope will tell you important information about people’s perceptions of changes in the resources over time. If the slope has a negative sign, it means the amount of that resource is perceived to be decreasing. If the slope of the sign is positive, the reverse is true. The resource is perceived to be increasing. You also can check how well the equation fits the data by looking at the R-square. The higher the R-square, the better the fit.

26 If you find the p-value is not significant, it doesn’t mean the data do not have a pattern or trend over time. They may have a non-linear trend (i.e., quadratic, cubic, etc.). Excel does not provide analyses tools for non-linear trends. You can use more sophisticated statistical software, such as SPSS, SAS or Minitab, in such cases.

27 The R-sq is very sensitive to outliers and influential observation. There are several statistic instead of R-sq which has been introduced for assessing goodness of fit, including PRESS statistic (Draper & Smith 1982). However for our simple model, R-sq is adequate.
c. Checking model validity

Regression analysis, which has been used widely to model the relationship between two variables, has several assumptions that need to be satisfied to get a valid (reliable) model. Those assumptions are normality of residuals, homogeneity of residual variances, uncorrelated residuals, etc. More detailed discussion on those assumptions can be found in (Draper & Smith 1981), although appendix A in this manual might give you insight how to investigate those assumptions using explanatory and graphic approach. However, we strongly suggest you use statistical software, such as Minitab, SAS, and SPSS, to perform more a detailed inspection. Because our data are similar to time series data, it is more likely there will be correlated residuals that violate the assumptions. In this case, autoregressive regression (Makridakis et al. 1983).

2. ACCESS TO RESOURCES BY GENERATION GUIDELINES
This section first provides information on how to set up a spreadsheet and enter the data for the pebble distribution method on access to resources by generation (in The BAG). Next, we explain how to perform simple statistical analyses on the data, including how to check data distribution and generate simple descriptive tables. For those of you who are satisfied with simple analyses, you can stop there. The final part is intended for those who want to conduct more advanced analyses, such as testing the significance of differences of opinion among different groups (based on ethnicity, age, gender, etc.).

a. Entering the data

- Enter the data using spreadsheet software, such as Excel or Lotus, if possible.

- Enter the demographic data, such as user group, gender, age, educational level, etc., in the left-hand columns (as shown in Figure 9, columns A–D). Insofar as possible, enter the demographic data using numeric codes. If you have categorical data, such as gender, educational level, etc., you need to convert them into numeric codes (e.g., female = 0, male = 1, etc.). It is very important to keep a coding sheet, so you will know the meaning of each code. You will need it when you undertake the analysis. We suggest you record the coding information within the spreadsheet.
You can use the next column to enter the amount of pebbles for each generation (i.e., grandparent, me, grandchild) allocated by the respondent. You only need one row for each respondent.

After you finish entering the data for all respondents, do not forget to save the file in Lotus 123 format (*.wk1).

b. Conducting simple data analyses using SPSS

We use SPSS (Statistical Package for Social Sciences) to analyse the data.

- Opening the data — You can open the Lotus 123 file in an SPSS spreadsheet. Use the read variable name option.

---

28 Usually we use three categories, grandparents, me, and grandchildren, but the East Kalimantan team (1997) added two more categories: parents and children.

29 We have also made guidelines for those of you who want to undertake simple analyses using Excel (see Part c of this section).

30 From the SPSS menu bar, you can choose File → Open, then change the file type to Lotus (*.wk1) and choose the file you want to open. The SPSS processor automatically will ask you whether you want to read the variable name or not. Just click on the ‘read the variable names’ option.
• **Labelling the data** — Use the coding sheet (the one that you made when you coded the demographic data into a numeric code to label the data). For labelling the data, place the cursor at the column where the demographic data are. Below is an example of labelling gender data.

From menus, choose:  

Data  
Define variable (Figure 10)

Click **Label** button (shown by the arrow).  
You will be asked to enter your label (Figure 11).
Follow the same procedure for the other demographic data.

• **Checking data distribution** — Commonly, we calculate a mean/average to measure the distribution of pebbles according to the respondents. However, using the mean has some disadvantages when the data are not spread symmetrically or when there are one or more outliers. If this occurs, we can use median value instead. To check whether the data are spread symmetrically or not we can use a boxplot. We check the data for each generation separately, since each generation was considered as a separate variable. If the majority of the generations were distributed asymmetrically, we would use the median instead. On the other hand, if the majority of generations was distributed symmetrically, we could use the mean/average.
You can obtain a boxplot by following these instructions:

- From menu, choose **Graphs**
  - **Boxplot**

Choose *simple* and summaries for separate variables (Figure 12).

- Click on **Define** button.

- Enter all the generations as variables (Figure 13) and then click **OK**.

You will get the Boxplot as shown in Figure 14. The black line inside the box shows the median position. The upper and lower edges of the box show the position of the 3rd and 1st quartiles, respectively. The data are distributed symmetrically if and only if the median is located in the middle of the box, at approximately the same distance from both the 3rd and 1st quartiles.
FIGURE 12. Choosing type of boxplot for inter-generation data

FIGURE 13. Choosing variables of inter-generation data (for checking data distribution)
If the data distribution is highly skewed or there are some outliers (usually indicated by asterisks or circles), we suggest you use the median instead. In these boxplots above, we considered me and grandchild as having an asymmetric distribution since the median position is skewed and there are also some outliers. Hence, we use a median for analysing inter-generation data.

- Generating the table that describes the distribution of access to resources across generation, according to all respondents

  From the menu, choose: Statistics
  Custom Tables
  Basic Tables
Put all generations in summaries item. You can do this by clicking the variable name and then clicking on the arrow in front of the summaries box (Figure 15).

Click on the Statistics button and add Mean or Median (depend on which measure you decide to use) as the cell's statistics.

By clicking the OK button, you will get the results (Figure 16).
c. Conducting simple analyses using Excel

- Generating the table that describes the pebble distribution, according to all respondents

From the Data Menu, choose PivotTable Report. You will see the dialogue box as shown in Figure 17.
Click on Next> button twice, and you will see a dialogue box as shown in Figure 18.
Drag all the generations into the data space (Figure 19).

The sum is the default statistic. You can change the statistic by clicking on the button and choosing the statistic that you want to calculate31 (Figure 20).

![Figure 19](image-url) Constructing a pivot table for simple analysis on inter-generation data (Step 2)

31 The statistics provided by Excel do not include Median. If you want to use median, you must use another software, such as SPSS.
After you have decided on the appropriate statistic, you can click the **Finish** button and you will get the table as shown in Figure 21. If you prefer a smaller number of digits, you can set the decimal place.

![Figure 20. Changing the default statistic on inter-generation data](image)

---

To set the decimal place, go to the **Format** menu, choose cells and under category choose numbers. Then you can set the decimal place by increasing or decreasing the default decimal place (default=2).
d. Conducting advanced data analysis using SPSS

- Generating the table that describes the distribution of access to resources across generation, according to a particular subgroup

Sometimes, it is interesting to compare different subgroups within each demographic element (ethnicity, gender, educational level, etc.) according to their opinions on the distribution of pebbles among stakeholders. To compare those subgroups’ opinions, we need to know the distribution of pebbles among generations, according to each subgroup. You can follow our instructions below to get those figures. Imagine that we have a set of respondents from three ethnic groups, Baka, Kako, and Nzime33.

33 These ethnic groups inhabit the Dja Reserve area, Cameroon (Tchikangwa et al. 1998).
From the menu, choose: Statistics
Custom Tables
Basic Tables

Put all generations in summaries item. You can do this by clicking the variable name and then clicking on the arrow in front of the summaries box (Figure 22).

Put the column containing data of subgroups we want to compare into subgroups-down item (Figure 23). In our case, information about ethnicity is in the Ethnic column. Then, click OK.
Now, we can compare the differences of pebble distribution for each generation according to the three ethnic groups (Figure 24).
If you have more than three categories in your demographic data (e.g., four or more ethnic groups), you can continue this same step to get the mean/median value of pebble distribution among stakeholders for the other categories.

- Testing agreement/disagreement among different groups on the distribution of access to resources across generation—You can check whether there is agreement or disagreement among the different groups about the amount of pebbles attributed to each generation.

From the menu, choose: Statistics Nonparametric test 2 independent samples or K independent samples (See Figure 25)

34 Groups here could be gender, educational level, ethnicity, etc.

35 If you would like to test data with only two categories or two groups, you should choose two independent samples and then use the Mann-Whitney test. If you are dealing with data in more than two categories, you should choose K-independent samples, and then use Kruskall-Wallis test.
Put the test variables into test variable list box and grouping variable into grouping variable box (Figure 26). You then should define a minimum and maximum value of the grouping variable (you can check the meaning of each code on your coding sheet). See Figure 27 for details.

*Test variables should be the column containing the pebbles data for each generation. The grouping variable is the column containing information of different groups that we want to compare.*
III - QUANTITATIVE ANALYSIS GUIDE

FIGURE 26. Selecting test variables and grouping variable (inter-generation data)

FIGURE 27. Defining the range for grouping (demographic) variable (inter-generation data)
Click Continue and then OK.

You will get the results as shown in Figure 28. The test will have to be carried out for each generation. Be sure to check the significance at each test.

See the P-value (indicated by the arrow). If the P-value falls below 0.05, we reject the null hypothesis and conclude there is disagreement among the groups about the amount of pebbles belonging to each generation. If the P-value falls above 0.05 then we conclude there is agreement among the different groups. The test was carried out for each generation; be sure to check the test significance for each generation.

FIGURE 28. Output of the statistical test for each generation (inter-generation data)

The null hypothesis is that all the subgroups allocated the same amount of pebbles for each generation. In the other words, they agreed about the amount of pebbles attributed to each generation.
e. Conducting advanced data analysis using Excel

- Generating the table that describes the distribution of access to resources across generation, according to particular subgroups.

You can use a similar procedure to what you did to get a table of pebble distribution according to all respondents (Part c of this section). The differences will be when you construct the pivot table. Instead of just dragging all generations to the data space, you must also drag the column where the particular subgroups are into the column space\(^3\) (Figure 29). Here we use ethnic groups as an example.

---

\(3\) Subgroups here can be gender, educational level, age, ethnicity, etc.
By clicking the **Finish** button you will get the result (Figure 30). Notice the two subtables for each ethnic group (in this example, as in the previous one, ethnic1 means Baka, ethnic2 means Kako, while ethnic3 means Nzime).

![Figure 30](image-url)  
**FIGURE 30.** Excel table describing comparison of distribution of access to resources across generation based on ethnicity.

3. **BENEFIT SHARING AMONG STAKEHOLDERS: GUIDELINES**

This section provides information on how to set up a spreadsheet for the pebble distribution method on benefit sharing among stakeholders (method described in *The Grab Bag*), and how to enter the data. Next we explain how to perform simple statistical analyses on the data, mainly how to see how the data are distributed and how to generate simple descriptive tables. For those of you who are satisfied with simple analyses, you can stop there. Finally, we provide help for those who want to have more advanced analysis such as testing the significance of opinion differences among different groups (based on ethnicity, age, gender, etc.).
a. Entering the data

- Enter the data using spreadsheet software, such as Excel or Lotus.
- Enter the demographic data, such as user group, gender, age, educational level, etc., in the left-hand columns (Figure 31, columns A–F). Insofar as possible, enter the demographic data using numeric codes. If you have categorical data, such as gender, educational level, etc., you need to convert them into numeric codes (e.g., female = 0, male = 1). It is very important to keep the coding sheet, so you will know the meaning of each code. We recommend you also store the coding information somewhere in the spreadsheet.
- Use one row for each stakeholder. For example, in Figure 31, we include a data set from Long Segar where we identified 7 stakeholders. You should use rows 2–8 (7 rows) for respon-

**FIGURE 31. Spreadsheets format for forest benefits data**
dent1, rows 9–15 (7 rows) for respondent2 and so on. You need one column in which to enter the stakeholder’s code, indicating which rows belong to which stakeholders. Column F in our example above contains the stakeholder’s code.

• In the next column, you can enter the amount of pebbles for each stakeholder allocated by the respondents. You need one column for each benefit. In our example above, we use column G for cash, column H for timber, and so on (Figure 31).

• After you finish entering the data for all respondents, do not forget to save the file into Lotus 123 format (*.wk1).

b. Conducting simple data analyses using SPSS

We use SPSS (Statistical Package for Social Sciences) to analyse the data.

• Opening the data — You can open the Lotus 123 file in an SPSS spreadsheet. Use the 'read variable name' option.

• Labelling the data — Use the coding sheet that you made when you coded the demographic data into a numeric code to label the data. For labelling the data, place the cursor at the column where the demographic data are. Here, we give an example to label educational level data.

39 Each stakeholder was coded using a number. If we have \( n \) stakeholders, we can assign a unique number to each stakeholder arbitrarily. But we suggest you code the stakeholders in a mnemonic fashion that will make your analysis easier. You might, for example, assign 1 to local people, 2 to contractors and traders, and 3 to government and timber concessions. Your coding scheme will depend on your planned use.

40 We also made guidelines for those of you who want to carry out simple analyses using Excel (see Part c of this section).

41 From the SPSS menu bar, you can choose File → Open, then change the file type to Lotus (*.wk1) and choose the file you want to open. The SPSS processor automatically will ask you whether you want to read the variable name or not. Just click on the 'read the variable name' option.
From the menu, choose: Data
Define variable
(Figure 32).

Click Label button (shown by the arrow). You will be asked to enter your label (Figure 33).
Enter the demographic label (e.g., junior high school, in the example above) and when you finish click Continue.

Follow the same procedure for the other demographic data.

• Checking data distribution

Commonly, we calculate a mean/average to measure the distribution of pebbles according to the respondents. However, using the mean has some disadvantages when the data are not spread symmetrically or when there are one or more outliers. If this occurs, we can use the median value instead. To check whether the data are spread symmetrically or not, we use a boxplot. With this method we check the data for each benefit separately, because those benefits were considered as separate variables. If the majority of the benefits were distributed asymmetrically, we would use a median instead. On the other
hand, if the majority of benefits were distributed symmetrically we should use the mean/average.

You can obtain a boxplot by following these instructions:

1. From the menu, choose: **Graphs**
   - **Boxplot**

   Choose **clustered** and **summaries** for separate variables (Figure 34).

2. Click on **Define** button.

3. Enter all the benefits as variables and **stake**$^{42}$ as the category axis (Figure 35).

4. You will get the Boxplot, as shown in Figure 36. The black line inside the box shows the median position. The upper and lower edges of the box show the position of the 3rd and 1st quartiles, respectively. The data are distributed symmetrically if and only if the median is located in the middle of the box, at approximately the same distance from both the 3rd and 1st quartiles.

---

$^{42}$ Stake is the column containing the stakeholder’s code. In this example, we use stake, an abbreviation of **stakeholders**, to name the column. You can use a different name, of course.
III - QUANTITATIVE ANALYSIS GUIDE

FIGURE 34. Choosing type of boxplot for forest benefits data

FIGURE 35. Choosing variables of forest benefits data (for checking data distribution)
If the data distribution is highly skewed or there are some outliers (usually indicated by asterisks or circles), we suggest you use the median instead.

- Generating the table that describes the forest benefits distribution, according to all respondents

- From the menu, choose: Statistics
  - Custom Tables
  - Basic Tables

- Put all benefits in the summaries item. You can do this by clicking the column name and clicking on the arrow in the summaries box (Figure 37).
Put stake in subgroups – down item (Figure 38)

FIGURE 37. Step 1 of selecting variables of forest benefits data (for summarising)

FIGURE 38. Step 2 of selecting variables of forest benefits data (for summarising)
Click on the Statistics button and add Mean or Median (depend on which measure you decide to use) as the cell’s statistics.

By clicking the OK button, you will get the results (Figure 39).

---

c. Conducting simple analysis using Excel

- Generating the table that describes forest benefits distribution, according to all respondents

From the Data Menu, choose PivotTable report. You will see a dialogue box as shown in Figure 40.
Click on Next button twice and you will see a dialogue box as shown in Figure 41.
Drag all columns where the data for forest benefits are into the data space and column where codes for stakeholders are into column space (Figure 42).

The sum is the default statistic. You can change the statistic by clicking on the button and choosing the statistic that you want to calculate (Figure 43).
After you finish changing the statistic, you can click the Finish button and you will get the table as shown in Figure 44. If you prefer a smaller number of digits, you can set the decimal place.  

43 To set the decimal place, you can go to the Format menu, choose cells, and under category, choose Numbers. Then you can set the decimal place that you want by increasing or decreasing the default decimal place (default = 2).
d. Conducting advanced data analyses using SPSS

- Generating the table that describes forest benefits distribution, according to a particular subgroup.

As in the case of the ‘access to resources by generation’ pebble sorting method, for which analysis was described earlier, it may be useful to compare different subgroups within each demographic element (ethnicity, gender, educational level, etc.), according to their opinions on the distribution of pebbles among stakeholders. To compare those subgroups’ opinions, we need to be able to describe forest benefits distribution among stakeholders, according to each subgroup. You can follow our instructions below to get those figures. Imagine that we have a set of respondents with two educational levels, elementary and junior high school.
From the Menu choose **Data**
Select **Cases**
Click on *if condition is satisfied* (Figure 45).

Click on the *If* button.

Look at your coding sheet to determine the codes for elementary school and junior high school (for instance, you may have elementary school = 1, junior high school = 2)

Type in the conditional box (Figure 46):
\(educ = 1\) (you will filter the data which has a value of 1 on the *educate* column)
Then click Continue and OK (Figure 46).

Now, if you notice on the SPSS spreadsheet, there may be rows with values that are not equal to 1 on educ column. These are respondents with junior high school educational level and are not included in the analysis, thus are inactive. This inactive status is marked by a diagonal line at the row number (see Figure 47).
Do the same step as the fourth step of Part b of this section, for getting the average pebble distribution according to respondents with an elementary school educational level (Figure 48).

To get the average pebble distribution according to respondents with a junior high school educational level, simply change the conditional expression to:

\[ \text{educ} = 2 \]

Then do the same steps as in the fourth step of Part b of this section, as above.
Now, we can compare the differences of forest benefits distribution among two groups of stakeholders with different educational levels (Figure 49).

FIGURE 48. Forest benefits distribution among stakeholders according to respondents with lower educational level

FIGURE 49. Comparison of forest benefits distribution among stakeholders based on educational level
If you have more than two categories in your demographic data (e.g., three or more educational levels), you can continue this same step to get the mean/median value of pebble distribution among stakeholders for the other categories.

- Testing agreement/disagreement among different groups on the distribution of forest benefits

You can check whether there is agreement or disagreement among the subgroups within each demographic characteristic\(^{44}\) about the amount of forest benefits attributed to each stakeholder. You can do the analysis for each stakeholder. Filter the data so that only rows for selected stakeholders are active and the other rows are inactive (see above, on how to filter subgroups of data). In Figure 50, we filter the data so that only rows for Stake = 1 (Kenyah) are active while the others are inactive.

From menu, choose: Statistics
Nonparametric test
\(2\) independent samples or
\(K\) independent samples\(^{45}\)

---

\(^{44}\) Demographics characteristics here could be gender, educational level, ethnicity, etc.

\(^{45}\) If you would like to test the data with only two categories or two groups, you should choose \(2\) independent samples and then use the Mann-Whitney test. If you are dealing with data in more than two categories, you should choose \(K\) independent samples, and then use the Kruskall-Wallis test.
Put the test variables into the test variable list box and grouping variable into the grouping variable box (Figure 51). You then should define a minimum and a maximum value of the grouping variable (you can see the meaning of each code on your coding sheet). See Figure 52 for details.

'Test variables' should be the column containing the pebble for each benefit. The grouping variable is the column containing the demographic characteristics of subgroups that we want to compare.
III - QUANTITATIVE ANALYSIS GUIDE

FIGURE 51. Selecting test variables and grouping variable (forest benefits data)

FIGURE 52. Defining the range for grouping variable (forest benefits data)
Click **Continue** and then **OK**.

You will get the results as shown in Figure 53. The test will be carried out for each benefit. Be sure to check the significance of each test.

See the P-value (indicated by the arrow). If the P-value falls below 0.05, we reject the null hypothesis and conclude there is disagreement among the groups about the amount of pebbles belonging to the selected stakeholder (Kenyah, in this case). If the P-value falls above 0.05, then we conclude there is agreement among the different groups.

Do the same step to test agreement/disagreement about the amount of forest benefits attributed to the other stakeholders. For instance, if you want to check agreement/disagreement among different groups on amount of pebbles attributed to Kutai, you can filter the data so that only rows with Stake = 2 (Kutai) are active while the others are inactive.

---

47 Under each forest benefit, the null hypothesis is: That all the subgroups allocated the same amount of pebbles for the stakeholder being tested. In the other words, all subgroups agreed about the amount of corresponding forest benefits attributed to the stakeholder being tested.
e. Conducting advanced data analysis using Excel

- Generating the table that describes forest benefits distribution, according to a particular subgroup

You can use a similar procedure to generate a table of forest benefits distribution according to all respondents (Part c of this section). The difference will be when you construct the pivot table. Instead of just dragging all benefits to the data space and stakeholders to the column space, you must also drag the column where the particular demographic characteristics are into the row space48 (Figure 54). In this example, we use educational level.

---

48 Demographic characteristics here can be gender, educational level, age, ethnicity, etc.
By clicking the Finish button, you will get the result (Figure 55). Notice the two sub-tables for each educational level (in this example, as in the previous one, educational level 1 means elementary school, while educational level 2 means junior high school).
### FIGURE 55. Excel table describing comparison of forest benefits distribution based on educational level

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Label</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
<tr>
<td>2</td>
<td>Total</td>
<td>Average of Cash</td>
<td>22.5</td>
<td>22.5</td>
<td>12.5</td>
<td>27.5</td>
</tr>
<tr>
<td>3</td>
<td>Average of Wood</td>
<td>22.5</td>
<td>22.5</td>
<td>12.5</td>
<td>37.5</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Average of Bathroom</td>
<td>22.5</td>
<td>22.5</td>
<td>20.5</td>
<td>6.5</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Average of Furniture</td>
<td>22.5</td>
<td>22.5</td>
<td>22.5</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Average of Medicine</td>
<td>40.0</td>
<td>40.0</td>
<td>15.0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Average of NPF</td>
<td>22.5</td>
<td>22.5</td>
<td>11.5</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Total Average of Cash</td>
<td>21.7</td>
<td>21.7</td>
<td>12.5</td>
<td>27.5</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Total Average of Wood</td>
<td>22.5</td>
<td>22.5</td>
<td>12.5</td>
<td>37.5</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Total Average of Bathroom</td>
<td>22.5</td>
<td>22.5</td>
<td>20.5</td>
<td>6.5</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Total Average of Furniture</td>
<td>22.5</td>
<td>22.5</td>
<td>22.5</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Total Average of Medicine</td>
<td>40.0</td>
<td>40.0</td>
<td>15.0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Total Average of NPF</td>
<td>22.5</td>
<td>22.5</td>
<td>11.5</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
C – ANALYSIS OF METHODS FOR RIGHTS AND MEANS TO MANAGE

This section contains guidance for analysing the results from a pebble distribution method found useful in assessing people’s rights and means to manage forests in a co-operative and equitable manner. We have divided the presentation into three parts. We first provide information on how to set up the spreadsheet and enter the data from this pebble distribution method. Next, we explain how to perform simple statistical analyses on the data, including how to examine the data distribution and how to generate simple descriptive tables. For those of you who are satisfied with simple analyses, you can stop there. The final part is intended for those who want to conduct more advanced analyses, such as testing the significance of opinion differences among different groups within each demographic characteristics (based on ethnicity, age, gender, etc.).

1. RIGHTS TO MANAGE THE FOREST GUIDELINES

a. Entering the data

• Enter the data using a spreadsheet programme, such as Excel or Lotus.

• Enter the demographic data, such as user group, gender, age, educational level, etc. in the left-hand columns (as shown in Figure 56, columns A–F). Insofar as possible, enter the demographic data using numeric codes. So if you have categorical data, such as gender, educational level, etc., you need to convert them into numeric codes (e.g., female = 0, male = 1, etc.). It is very important to keep a coding sheet, so you will know the meaning of each code. You will need the coding sheet when you undertake the analysis.
• If you have a certain number \( (n) \) of stakeholders, you should use \( n \) rows for each respondent, or in other words, one row for each stakeholder. For example, in Figure 56, we use a data set from Bulungan\(^{49}\) where we identified 10 stakeholders. We use rows 2–11 (10 rows) for respondent1, rows 12–21 (10 rows) for respondent2, and so on. We need one column in which to enter the stakeholder's code\(^{50}\), indicating which rows belong to which stakeholders. Column G in our example above contains the stakeholder's code.

• You can enter the number of pebbles for each stakeholder allocated by the respondents in the next six columns. Column H for Right1 (Determining/protecting Boundaries), Column I for Right2 (Develop/apply Rules/Regulations), and so on.

49 Bulungan is located in East Kalimantan, Indonesia, one of CIFOR’s research sites.

50 Each stakeholder was coded using a number. If we have \( n \) stakeholders, we assign 1–\( n \) to each stakeholder arbitrarily. But we suggest you code the stakeholders in a mnemonic fashion that will make some sort of intuitive sense to you. In our analyses, big numbers were given to stakeholders with a close relationship with government and small numbers to local people, who in many cases have little interaction with the government.
III – QUANTITATIVE ANALYSIS GUIDE

- Use the next to the last column on the right (Right6) for getting the average of rights for each stakeholder. To get the average, simply use Excel’s AVERAGE function. For instance, cell N2 in Figure 56 is an average of cell H2 to cell M2 (shown by the arrow).

- After you finish entering the data for all respondents, don’t forget to save the file in Lotus 123 format (*.wk1).

b. Conducting simple data analyses using SPSS

We have used SPSS (Statistical Package for Social Sciences) to analyse the data.

- Opening the data—You can open the Lotus 123 file in an SPSS spreadsheet. Use the read variable name option.

- Labelling the data—Use the coding sheet, the one that you made when you coded the demographic data into numeric codes, to label the data. For labelling the data, place the cursor at the column containing the demographic data. Here we give an example to label educational level data.

  From the menu, choose: Data
  Define variable (Figure 57)

  Click Label button (shown by the arrow). You will be asked to enter your label (Figure 58).

---

51 To use the AVERAGE function, just type = AVERAGE (Start Cell:End Cell). Start and end cell is the range to be averaged. For example, in Figure 1, cell N2 is the average of H2 to M2 (shown by the arrow).

52 We have also made guidelines for those of you who want to carry out simple analyses using Excel (see Part c of this section).

53 From the SPSS menu bar, you can choose File → Open, then change the file type to Lotus (*.wk1) and choose the file you want to open. The SPSS processor automatically will ask you whether you want to read the variable name or not. Click on the ‘read the variable names’ option.
III – QUANTITATIVE ANALYSIS GUIDE

FIGURE 57. Label button (rights to manage data)

FIGURE 58. Defining labels for educational level data (rights to manage data)
Enter the demographic label (e.g., junior high school, in the example above) and when you finish, click Continue.

Follow the same procedure for the other demographic data.

• Checking data distribution

Commonly, we calculate a mean/average to measure the distribution of pebbles according to the respondents. However, using a mean has some disadvantages when the data are not spread symmetrically or when there are one or more outliers. If this occurs, we can use median value instead. To check whether the data are spread symmetrically or not, we use a boxplot.

You can obtain a boxplot by following these instructions:

From the menu, choose: Graph
Boxplot

Choose simple and summaries for groups of cases (Figure 59).

Click on Define.

Enter average of rights as variable and stake as category axis (Figure 60).

You will get the boxplot as shown in Figure 61. The black line inside the box shows the median position. The upper and lower edges of the box show the position of the 3rd and 1st quartiles, respectively. The data are distributed symmetrically if and
only if the median is located in the middle of the box, at approximately the same distance from both the 3rd and 1st quartiles.

FIGURE 59. Choosing type of boxplot for rights to manage data

FIGURE 60. Choosing variables of rights to manage data (for checking data distribution)
If the data distribution is highly skewed or there are some outliers (usually indicated by asterisks or circles), we suggest you use the median instead.

- Generating the table that describes the pebble distribution according to all respondents

From the menu, choose: Statistics
        Custom Tables
        Basic Tables

Put average of rights in the summaries box. You can do this by clicking the column name and clicking on the arrow beside the summaries box (Figure 62).
Put stake in subgroups – down box (Figure 63).

FIGURE 63. Step 2 of selecting variables of rights to manage data (for summarising)
Click on Statistics button and add Mean or Median (depending on which measure you decide to use) as the cell’s statistics.

By clicking the OK button, you will get the results (Figure 64).

FIGURE 64. SPSS table describing distribution of rights to manage among stakeholders, according to all respondents.
c. Conducting simple data analysis using Excel

- Generating the table that describes the distribution of rights to manage, according to all respondents

From the Data Menu choose, PivotTable report, you will see the dialogue box as shown in Figure 65.

![Pivot table wizard (rights to manage data)](image)

FIGURE 65. Pivot table wizard (rights to manage data)

Click on Next button twice and you will see the dialogue box as shown in Figure 66.
Drag average of rights into data space and stakeholders to row space (Figure 67).
The sum is the default statistic. You can change the statistic by double-clicking the button and choosing the statistic that you want to calculate (Figure 68).

After, you have decided on the appropriate statistic, you can click the **Finish** button and you will get the table as shown in Figure 69. If you prefer a smaller number of digits, you can set the decimal place.  

54 To set the decimal place, go to Format menu, choose cells and under category, choose numbers. Then you can set the decimal place that you want by increasing or decreasing the default Decimal place (default = 2).
d. Conducting advanced data analyses using SPSS

- Generating a table that describes the distribution of rights to manage, according to a particular subgroup

Sometimes, it is interesting to compare different subgroups’ opinions within each demographic characteristic (ethnicity, gender, educational levels, etc.) on the distribution of pebbles among stakeholders. To compare those subgroups’ opinions, we need to know the figures that describe the distribution of rights to manage among stakeholders according to each subgroup. You can follow our instructions below. Imagine we have a set of respondents with two educational levels, elementary and junior high school.
From the menu, choose: **Data**

Select **Cases**

Tick on *if condition is satisfied* (Figure 70)

Click on the **If** button.

Look at your coding sheet to determine the codes for elementary school and junior high school (for instance, you may have elementary school = 1, junior high school = 2)

Type in the conditional box $\text{educate} = 1$ (you will filter the data which has a value of 1 on $\text{educate}$ column).
Then click **Continue** and **OK** (Figure 71).

![FIGURE 71. Filtering with a lower educational level respondents on rights to manage data](image)

Now, if you notice on the SPSS spreadsheet, there may be rows with values not equal to 1 in the **educate** column. These are respondents with higher educational level and are not included in the analysis, thus are inactive. This inactive status is marked by a diagonal line through the row number (see figure 72 for details).
Do the same step as in the fourth step of Part b of this section, for getting the average pebble distribution according to respondents with an elementary school educational level (see Figure 73).

To get the average pebble distribution according to respondents with a junior high school education level, simply change the conditional expression to:

\[ \text{Educate} = 2 \]

Then do the same step as in the fourth step of Part b of this section.
Now, we can compare the differences in pebble distribution among two groups of stakeholders with different educational levels (Figure 74).

If you have more than two categories in your demographic data, you can do the same step to get the mean/median value of pebble distribution among stakeholders.

FIGURE 73. Distribution of rights to manage among stakeholders, according to respondents with a lower educational level.
• Testing agreement/disagreement among different groups on the distribution of rights to manage

You can check whether there is agreement or disagreement among the different groups within each demographic characteristic\(^{55}\) about the amount of rights attributed to specified stakeholders. You can do the analysis for each stakeholder. What you should do first is filter the data so that only rows for specified stakeholders are active while the other rows are inactive. In this case, we filter data attributed to Punan (Stake = 1) only (see Figure 75). For detailed guidance on how to filter the data, see the first step of Part d of this section.

\(^{55}\) Demographic characteristics here could be gender, educational level, ethnicity, etc.
From the menu, choose: Statistics
Nonparametric test
2 independent samples or
K independent samples
(See Figure 76)

If you would like to test the data with only two categories or two groups, you should choose two independent samples and then use the Mann-Whitney test. If you are dealing with data with more than two categories, you should choose K-independent samples, and then use the Kruskall-Wallis test.
Put the test variable into the test variable list box and the grouping variable into the grouping variable box (Figure 77). Then, you should define a minimum and maximum value of the grouping variable as shown in Figure 78 (you can see the meaning of each code on your coding sheet).

57 The test variable should be the column containing the average of rights. The grouping variable is the column containing demographic characteristics that we want to compare.
### III - QUANTITATIVE ANALYSIS GUIDE

**FIGURE 77.** Selecting test variables and grouping variables (rights to manage data)

**FIGURE 78.** Defining the range for grouping variable (rights to manage data)
Click Continue and then OK.

You will get the results as shown in Figure 79.

See the P-value (indicated by the arrow). If the P-value falls below 0.05, we reject the null hypothesis and conclude there is disagreement among the groups about the amount of pebbles belonging to the specified stakeholder. If the P-value exceeds 0.05 then we conclude there is agreement among the different groups.

You can undertake analysis for the other stakeholders as well, by changing the filtering statement. For instance if you want to test the amount of pebbles attributed to Lundaye (look at your coding sheet and get the code for Lundaye, Stake = 2). Then change the filtering status in Figure 18 to Stake = 2 and run the same procedure to obtain the statistical test.

58 The null hypothesis is: That all subgroups allocated the same amount of pebbles for the stakeholder being tested. In the other words, all subgroups agreed about the amount of rights attributed to the stakeholders being tested.

59 Lundaye is one of the major ethnic group in Paking, Bulungan, where we undertook our field test.
e. Conducting advanced data analysis using Excel

- Generating a table that describes the pebble distribution, according to particular subgroups

You can do a similar procedure as the one for getting a table of pebble distribution according to all respondents. The differences will start when you construct the pivot table. Instead of just dragging all benefits to the data space and the stakeholder to the row space, you must also drag the column where the particular sub groups are into the column space^60 (Figure 80). In this example, we use the educational level as an example.

^60 Sub groups here can be gender, educational level, age, ethnicity, etc.
By clicking the **Finish** button, you will get the result (Figure 81). There are two sub-tables, one for each educational level (in this example, as the previous one, educational level = 1 means elementary school, while educational level = 2 means junior high school).
### FIGURE 81. Excel table describing comparison of rights to manage distribution based on educational level

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Average of Right</td>
<td>Educate</td>
<td>2</td>
<td>Grand Total</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Steps</td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>16.51</td>
<td>800.57</td>
<td>14.95</td>
<td>639.6</td>
<td>17.41</td>
<td>537.1</td>
</tr>
</tbody>
</table>

**Score and Analysis Guide for Assessing Human Well-Being**

133
D – CONCLUSIONS

This manual has been designed for use with CIFOR’s other C&I tools, particularly The BAG and The Grab Bag. The Scoring and Analysis Guide has covered three main topics: a scoring guide, guidelines on developing a master C&I spreadsheet for use with the scoring guide, and an analysis guide. The first (Section I) provided the user with some global comparisons of conditions, linked to scores considered reasonable by the authors and based on considerable field experience in testing C&I. The purpose was to aid users in making assessments of conditions they encounter in the field, linked to human well-being. The second (II) was designed for users who are relatively unfamiliar with computer spreadsheet use, and explained both the process of making and using a spreadsheet, and provided more details about a proposed, overall scoring method. The third and longest, Section III, provided considerable detail on ways to analyse the results from several of the quantitative methods described in The BAG and The Grab Bag. This manual is to be used as a reference document, with users going directly to the section most relevant for their particular needs.

We have tried to provide assistance and guidance in the difficult task of assessing, scoring, and analysing data resulting from assessment procedures. Although we have found these procedures helpful, we recognise that the task of assessment and the judgements required remain formidable. Assessing human well-being is not an easy task.

We remain convinced that the best assessments will result from experienced and sympathetic assessors who continue to use their minds in creative and constructive ways as they go through the procedures suggested in this manual. We have not yet reached a state in the assessment of sustainable forest management, including human well-being, where we can follow procedures blindly and come up with sen-
sible conclusions. We conclude by urging users to keep their minds engaged as they examine the conditions of the people in and around the forests they are assessing.
BIBLIOGRAPHY


APPENDIX A: CHECKING REGRESSION ANALYSIS ASSUMPTIONS

1. HOMOGENEITY OF RESIDUAL VARIANCES (HOMOSCEDASTICITY)

By homoscedasticity we mean the residual variances is constant for any value of the independent variable (X). A cone-shaped distribution of residuals against the fitted value may give first sight that the residuals variances is not constant (see Figures 82a and 82b). A model that satisfies this assumption will have constant residual variances as shown in Figure 82c.

If the residual shows pattern a or b, you can use weighted linear regression (Draper & Smith 1981).

For further discussion on how to overcome this problem, please consult a statistician.

![Figure 82. Some patterns of residual variances](image)
2. NORMALITY OF RESIDUAL
Regression analysis assumes that the residuals of the model follow normal distribution with zero mean and unity standard deviations. There are many tests to check the normality assumption including the Kolmogorov-Smirnov-test, and the Shapiro-Wilk test. These tests can be easily performed using Minitab. However, we can check this assumption quickly using normal Q-Q plot.

When you run the regression analysis using Excel remember you have clicked on normal probability plot option. This option will produce a normal quantile-quantile (Q-Q) plot, as shown in Figure 83.

![Normal Probability Plot](image)

**FIGURE 83. Normal probability plot of residual**

---

61 X is said to follow normal distribution if its probability function, \( f(x) \) approximately equal to \( \frac{1}{\sqrt{2\pi\sigma^2}} e^{-\frac{(x-\mu)^2}{2\sigma^2}} \), where \( \mu \) and \( \sigma^2 \), respectively, are mean and variances of the variable.
If the residual patterns follow a straight line, we may conclude that the residual was distributed following a normal distribution assumption. The more the residuals depart from straight line pattern, the more likely residual was not distributed following normal distribution. If this occurs, more detailed tests such as those suggested above should be used. Please consult a statistician on how to perform and to draw conclusions from the test.

3. UNCORRELATED RESIDUAL
In regression analysis, we assume that the observational errors are uncorrelated. There are, of course, many cases where the residuals may be correlated (Draper & Smith 1981). This kind of phenomenon more often occurs when we deal with time series data. The most common pattern we may find is that the residual from the $i^{th}$ (in time sequence) observation has linear relationship with residual for the $(i-1)^{th}$ observation. Figure 84a and 84b show two plots that reveal functional relationships between residuals. Figure 84a shows positive trend between one step apart residuals; meanwhile, Figure 84b shows a negative trend between the residuals.

The correlation between the $i^{th}$ and $(i-1)^{th}$ observations was called lag-1 serial correlation. To view the existence of serial correlation of larger lag, you can plots the residual two steps apart, three steps apart, and so on. In the presence of autocorrelated residual, several methods can be used, including autoregressive regression.
FIGURE 84. Plots show autocorrelated residual
The Scoring and Analysis Guide for Assessing Human Well-Being is designed to supplement The BAG and The Grab Bag. It provides a scoring method that can be used with the two manuals, to come to a decision about particular criteria and indicators in particular forest and human settings. Following the section on scoring is a section on analysis. It begins very simply, leading the user through the steps of making a spreadsheet, and concluding with more complex statistical analyses that may be desirable in some circumstances. Different teams have different requirements for quantitative and statistical sophistication in their analyses. This manual responds to these differing needs.